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PREFACE

Punjab School Education Board has been updating the school level syllabi 

compatible with modern approach and latest research. The board has also 

launched a special drive to prepare new text books as per latest national policies 

in this regard. The present book is a part of the prestigious program.

 The knowledge in the subject of computer science is the need of the hour 

because its study is essential for enhancement of efficient usage of science and 

technology in every field of modern ere. Computerization of every department 

is done to keep it updated in light of all round development of information 

technology and communication. The knowledge of computer education is 

necessary for everyone to avail the latest information about different 

departments, e-ticketing and usage of internet.

 Keeping in view of these requirements Punjab School Education Board 

has introduced computer science as a compulsory subject at Secondary and 

Senior Secondary levels as per guidelines of Punjab Government. This subject 

is already taught by PICTES in Government Schools. Every effort has been 

made to include each requisite information regarding the subject in this book. I 

hope it will be useful for students and teachers.

 All suggestions for the improvement of the book will be highly 

appreciated.

              Chairman

Punjab School Education Board
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Answers Key
Questions Multiple Choice Fill in the Blanks Trueor

False
Very Short Answer

1. Spread sheet System software and
application software FALSE .docx

2. End Organize andmanage TRUE .xlsx
3. Red Portrait or landscape TRUE .pptx

4. Animation JPEG (.jpg), GIF (.gif) TRUE Bitmap

5. Margin Audio and videos - Permanent Document
Format
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2.1   Introduction

The Internet is rapidly becoming a key resource for locating information 
relevant to a particular field.  The Internet has been called the "network of 
networks." Simply put, it's a way to link millions of people around the world, 
each of whom is using a computer, smart phone, tab etc. connected to a smaller 
network through ISP. Nobody owns or controls the Internet or the World Wide 
Web, although millions of individuals and organizations control their own 
systems. Some task forces have been constituted for its smooth functioning. 
WWW is composed of millions of webpages containing text, graphics, sounds, 
videos and link to other webpages. Have you ever think which basic technology 
lies in writing these webpages, which we are using daily? We need a computer 
language to design these web pages. The Basic and frequently used language 
for designing a webpage is HTML. In this chapter we will discuss the basics of 
HTML.

2.2  What is HTML?

HTML stands for Hyper Text Markup Language. HTML is a language 
used for DESIGNING A WEB page in which text, graphics, and other 
information are organized, formatted, and linked together. HTML is a tag based 
Language, which specifies the web browser what operation has to be 
performed on the given text. Hypertext refers  to a text which acts as a link in 
markup language for describing web documents (web pages).A markup 
language is a set of markup tags, HTML documents are described by HTML 

Objectives of this chapter:

HTML FUNDAMENTALS 
Chapter 
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tags, Each HTML tag describes a distinct meaning for which it has been 
designed.

 HTML is extremely simple, Flexible, easy to learn, interactive, widely 
accepted Markup Language.

2.3  Basic structure of an HTML document

 An HTML document has two main parts:

l    The head section contains title that identifies the heading of Head.
the HTML document.

l    The body element contains the actual contents or information  Body.
that you want to display on a web page to the end user.

Fig: 2.1
The tags defined in the above structure basically define or instruct the web 
browser about the different operation to be performed on the text defined 
in the given TAGS. We will now explain the above structure.

 HTML document is started with <html> and ended 1.3.1 <HTML>
with</html>with this tag. This TAG informs the web browser 
from where a web page will start and where it ends. If the 
commands are not defined in tags then the commands are taken 
as text by the web browser.

1.3.2 <HEAD Tag> Head tag provides Header information. The 
document title is written in Head Tag. It always occurs in pair. 
Head Tag is considered very important for a web page. This is a 
container tag. It defines the Heading of the HTML document. It 
starts with<HEAD> TAG and ends with </HEAD> .This Tag is 
always defined below <HTML> and above <BODY>tag. It 

   <html> 
<head> 
<title>TITLE OF YOUR WEBPAGE </title> 
</head> 
<body> 
Information which user wants to show.
</body> 
</html>

HTML document contains the following syntax:-
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contains information regarding title of the webpage, keywords 
used by the search engines etc. It contains no text in itself. 

 Eg. <HEAD> <TITLE> First Web Page </TITLE> </HEAD>
2.3.3 <TITLE>TITLE tag defines the title of the webpage, which is to be 

displayed on the title bar of the web browser when the web page is 
loaded in the web browser. It is enclosed in between <TITLE> 
AND</TITLE>tags. It should be short and meaningful of <TITLE> 
First Web Page </TITLE>

2.3.4 <BODY>BODY tag contains the actual information to be displayed 
on the web browser. When the webpage is loaded in the web 
browser. It may contain any element or contents related to text, 
images, audio, video etc. These contents are defined with in 
<BODY> and </BODY> tags. e.g. <BODY>This is my first 
document in HTML document. </BODY>

Each Body tag has different characteristics. These characteristics 
(properties) are termed as attributes. We can select Background colour, text 
colour, font size etc. with these attributes.

2.4 CREATING AN HTML DOCUMENT:-
HTML webpages are plain text files that can be created using any text 

editor or word processor such as Notepad, WordPad, MS-word. The following 
steps are to be taken while creating and displaying a webpage.

1.  Open Notepad by clicking Start→All Programs→Accessories→Notepad
    or  by typing Notepad in the run window. Notepad will be opened asshown
     in fig.2.1

Fig: 2.2
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2. Now type the html code in the Notepad as Shown in the Fig. 2.2
 Click on FileÝ  Save menu option. A dialog box will appear as shown fig 2.2 

select where you want to save the file, enter your file name with an 
extension .html

Fig: 2.3  

2.4.1   VIEWING AN HTML DOCUMENT:-
 Any HTML document can be viewed using any web browser like Internet 
Explorer, Netscape Navigator, Mozilla Firefox, Opera or Google Chrome. Here 
Internet explorer is used in examples.

 To open Internet Explorer follow the underwritten steps:

 1. StartÝ  All Programs Ý Internet Explorer or start Ý Run Ý explore   

  in the text box and click OK.
2. Click FileÝOpen or press Ctrl + O from the keyboard, an open box   
 will appear  and select  html file as shown in fig 2.3
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3. Choose the path where file is stored and open it with open button. The 
webpage will be displayed in the browser as shown in fig 2.4:-

Fig: 2.4

Fig: 2.5
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2.5 Web Browsers:-
 Web browser is a software which is used to browse web pages. Some of 
commonly used web browses are :- 
 1. Internet Explorer    2. Google Chrome   
 3. Mozilla Firefox    4. Opera  
 2.6  HTML TAGS

 As to attract end users we have to make our web page attractive, which may 
include text , graphics, and links. In HTML we can use tags which are defined in angle 
brackets<>. The use of less-than and greater-than angle brackets surrounding an  
element creates what is known as a tag. Tags most commonly occur in pairs of opening 
and closing tags.
 These tags are also known as elements. These tags can be defined in 
two forms these are:-
 1. Container Tags.
 2. Empty Tags.

1 Container Tags:-The container is an area enclosed by the Opening and 
closing tags. Container tags come in pairs. Every tag which is opened must be closed. 
A container tag consists of a start tag and end tag, with the content inserted in 
between, for example: <tag name>content goes here...</tag name>

for example, when you want italic text, you will contain the text between 
opening <i>and closing </ i>. Html encloses the entire document in <html>  and 
</html>.

2 Empty Tags:-These elements are called empty or void and they only have a 
start tag as they don't have any content. They must not have an ending tag in HTML. 
For Example <BR> tag is used to break the given line from where it is used.

 Attribute of a tag defines the features of a given tag in its starting 
tag..

2.6.1 Some of the commonly used container tags are defined below:

Note:-
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Above tags are explained in the example .as shown in fig 2.6

Fig 2.6
The output will be displayed as shown in fig 2.7

2.7 Attributes:
2.71. Difference between Tag and Attribute:-

�
R? E  ? RRPG@S RC 

/. Tags are those instruction which displys 
information on webpage.  

/. An attribute defines a property of 
tags  

0. Tags  may contain attribute  0. Attribute is a part of opening Tag 
of an element. 

1. These are of two types:-Empty Tag and 
Container Tag 

1. Types of Attribute depend upon 
the tag used .i.e. each tag has its 

own number of attributes. 
2. Example:- 

<Table  > 
Here table is a tag. 

2,Cv_k njc8-                                     
<Table  Border=”3” > 

a. Here a table is the Tag and 
border is its attribute. 

�

Fig. 2.7
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2.8 Body tag with attributes
Body Tag is the main part of the HTML document in which whole information about 

the webpage resides. The main attributes of this tag are background, bgcolor and text.
Let us discuss these attributes used in Body Tag.
2.8.1 Background attribute is used to define the background of a webpage. This is 

explained with an example  in the figure as shown in  html code and output in fig 
2.8 and 2.9

<BODY BACKGROUND=”lampbg.jpg”>

2.8.2 Bgcolor attribute of body tag is used to change the background colour of the 
webpage. 

eg. <BODY BGCOLOR=”GREEN”> 
EXPLAINED as shown with html code and output in fig 2.10 and 2.11

Fig: 2.8 Fig: 2.9

Fig: 2.10 Fig: 2.11
2.8.3   Difference between BACKGROUND and BGCOLOR:  

32



2.8.4 Text attribute defines the color of the text and is defined with an example as 
shown with html code and output in fig 2.12and 2.13  <BODY BGCOLOR=”RED” 
TEXT=”WHITE”>

Fig: 2.12 Fig: 2.13

2.9 Formatting in HTML document 
2.9.1 Heading Tags:
The heading tag is used to fix the heading. There are 6 levels of heading . The 
levels are numbered as heading 1 to heading 6. All the letters of the heading in 
a given level have same font. The font size goes on decreasing as we move from 
heading 1 to heading 6. The heading in level 1 is expressed by tags <H1> and 
</H1>. Similarly in the heading in level 2 we use the tags <H2> and </H2>. 
<H6> is the lowest level. The font size in it is the smallest. Heading tag is used 
to define heading in a HTML document.HTML supports Six Heading Levels H1 
to H6. Heading tags are container tags.
 Example: <H1> Computer Education </H1>

The alignment attribute is used in heading tag. This aligns the text. 
ALIGN attributes are of three types viz. LEFT, RIGHT and CENTER.
These are explained with an example as shown with html code and output 
in fig 2.13and 2.14with html code and output: -

Fig: 2.14 Fig: 2.15
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2.9.2 FONT: -
Font is pre-defined style and size of the text. FONT is the style and shape of the text 

which is used in any document. It allows to format data on a given web page. 
Font has four main properties: 
1. Style: Font style can be changed in three ways - Bold, Italic and Underline. 

a. Font face: Face defines the type face to be used like writing.
2. Font colour: Font colour gives different colours to the text.
3. Font size: Font size changes size of text matter.

2.9.2.1. Face defines the type face to be used for the text.eg.
<FONT FACE=”ARIAL”>WELCOME TO HTML</FONT>
These are defined with an example as shown with html code and output in fig 

2.16 and 2.17

2.9.2.2 COLOR defines the colour of the font to be used. It is defined with an 
example as shown with html code and output in fig 2.18and 2.19

<FONT FACE=”ARIAL” color=”RED”>WELCOME TO HTML</FONT>

Fig: 2.18

Fig: 2.16

Fig: 2.19

Fig: 2.17
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2.9.2.3. SIZE defines the size of the font. It has values from 1 to 7, while 1 is the 
smallest and 7 is the largest font size. By default font size is 2. font size 1 means 
6 points, 2 means 12 points and so on.
 Example of font and its attributes are defined as shown with html code 
and output  in fig 2.20and 2.21: -

Fig: 2.21

Fig: 2.20
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2.9.3 Paragraph Tag:- It is a container tag which is used in Web page to 
make paragraph. Single large documents are not recommended in a 
webpage as it is not edited easily. So, it is highly recommended to divide the 
text or document in different sections which is possible through paragraph 
tag<P> When we use this tag a blank line is inserted before and after the 
paragraph automatically by the browser.

 Ex. <BODY> Computer is an electronic Machine. It is a data 
processing machine. <P> and has memory </P> <BODY>

This is a container tag. 
 The text will automatically go to the new line after tag <P> 
 <P ALIGN=”RIGHT”>
 <P ALIGN=”LEFT”>
 <P ALIGN=”JUSTIFY”>
 <P ALIGN=”CENTER”>
 EXAMPLE OF <P> TAG.WITH OUTPUT:-
This tag is defined with an example as shown with html code and output 
in fig 2.22and 2.23

Fig: 2.22

Fig: 2.23
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Paragraph <P> Tag Break <BR>Tag 
<p> tag Tag is a container element which marks a 
block of text as a paragraph in a webpage and the 
web browser leaves a line between two 
paragraphs. This tag has an attribute ALIGN, 
which can take three values - left, right and center 

.The <p> tag denotes a paragraph and ends with a 
</p> and is a container tag. 

1. < BR> tag is an empty element that 
is used to break a line and display 
the proceeding text from the next 
line, without giving any space 
between two lines. It has no 

attribute. The <BR> is a line break 
and is an empty tag. 

This tag is used to define paragraphs with in your 

text.  

This tag is simply a line break. It 

just jumps to the next line without 
any spacing or formatting options. 

Example:- <p>hello world</p> Example :- Hello<br>world! 

 

2.9.4 Empty TAG 
2.9.4.1  BREAK TAG<BR>

The line Break tag is used to start the text from the new line. This tag 
does not leave a blank line space as the paragraph tag does. The text jumps 
to the new line on using break tag. The tag <BR> is a symbol for line 
break.The<br>tag inserts a single line break. The <br>tag is an empty tag 
which means that it has no ending  tag.This is defined with an example as 
shown with html code and output in fig 2.24 and 2.25

2.9.5 Difference between Paragraph Tag and Break Tag.

2.9.6 HR Tag
The <HR> tag is used to insert horizontal line across the page. Its 
attributes are: 

l  Size : It is used to set the thickness of line. 
l��Width : It is used to set the length of line.
l  Align  : It is used to set the alignment of line.
l���Color : It is used to set the color of line. 
   These are explained in Fig 2.26and 2.27

Fig: 2.25Fig: 2.24
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2.10 Lists
           While accessing some information from the web, user prefers to 
read only the required information from the website. So, lists play an 
important role in defining important information in the form of few lines. 
For example. As the user wants to differentiate between two distinct 
objects, then it will be better to represent it in the form of lists. In HTML 
there are three types of lists available. 

These are as follow:-
1. Numbered Lists (Ordered List)
2. Bulleted Lists (Unordered List)
3. Definition Lists

2.10.1 ORDERED LIST :-
 Also known as numbered  list ,it is used to define a list in a specific  
or sequential order in which numbers are used. The basic tag used for 
Ordered list is <OL> tag at the starting and</OL> at the end of the list. 
Each item is marked with an<LI> (List Item)tag. By default the list is 
started with 1. But user can change the starting number.
ATTRIBUTES USED:- In an Ordered List the attributes used are “TYPE“ 
which have  values as 1(Arabic),A(upper case letter),a(Lower case 
letters),I(Upper case Romans),i (Lower case Romans).

Eg.<OL type=”I”>
 Second attribute used is START in which user can define his own 
starting value in the list.
  Eg.<OL Start=”5” Type=”i” >

Ordered List example is shown as follows inexample as shown with 
html code and output in fig 2.28and 2.29

Fig: 2.26 Fig: 2.27
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2.10.2    Unordered List (Bulleted List) :-
 The lists which have information related to each other but their 
sequence is not important are called Bulleted Lists. It has a starting tag as 
<UL> and ending tag as </UL>tag. Each item is marked with <LI>tag which 
stands for List Item.  Any number of elements can be added in it. This                
is defined with an example as shown with html code and output in fig 2.30            
and 2.31

Fig: 2.28

Fig: 2.30

Fig: 2.29

Fig: 2.31
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By default attribute used for bullet list are used as disc. But  these 
bulletscan be changed  by using an attribute as TYPE .It can be used in 
<UL> as well as in <LI> tag as per the requirement. the values support by 
this attribute is defined as 
  Disc (  )
  CIRCLE(  )
  SQUARE(  )
 These are explained and defined with an example as shown with html 
code and output in fig 2.32 and 2.33

2.10.3 Difference between Ordered List and Unordered List

Fig: 2.32 Fig: 2.33
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2.10.4   Definition List:-
 Definition list generally contains the definitions of different terms and 
their meaning. It starts with <DL> tag and ends with</DL>tag. It has two 
main tags definition Term <DT> and Definition Description <DD> tags. 
These are explained in the following example as shown in figure 2.34 and 
2.35 with html code and output.

Fig: 2.34

Fig: 2.35
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2.10.5 Nested Lists:-
 When a List is inserted in other list it is known as Nested List. We 
can explain the nested list with the following example as shown with html 
code and output in fig 2.36 and 2.37

2.11 IMAGES:-
 By now you know enough to write a very nice, text-based home page 
in HTML, but it is the ability of the Web to provide pictures, technically 
called images, graphics, or sometimes icons, that has made it so popular. 
In this following section we 'll learn how to place an image in our web page 
and attributes related to it. Various graphics formats used are  
.jpeg,.jpg,.gif, png etc.

To add an image to a webpage,  the tag used is <img 
SRC=””FILENAME”>.Here SRC defines the source of the image and file 
name defines the filename with extension of the image chosen.

NOTE:-The location of the image file must be defined properly. i.e. 
either the file is in the same folder in which web page is stored or User has 
to define the complete path of the file.

Eg If file is in the same folder then it can be defined as
<Img SRC=”green.jpeg”>
   OR
<img SRC=”C:\html\10class\green.jpeg”>
The attributes of image tag are defined below:-
1. ALT stands for "alternate text". This tells the browser that if it 

can't find the image, then just display this text.  For example a disabled 

Fig: 2.36 Fig: 2.37
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user using a screen reader,visit the webpage, When he mouse over the image, 
the alternate text pops up. 

Example  for this is as follows:
<Img SRC=”green.jpeg”  Alt=”green color image is shown”> and are 

explained with an example as shown with html code and output in fig 2.38 
and 2.39:-

2. WIDTH stands for the image in pixels as well as percentage of the 
web browser window. It can range from 1 pixel to any number, but 
generally   will be less than the width of the web browser.

3. HEIGHT stands for the height of the image in pixels or percentage 
of the web browser windows. Again, the height can be just about 
anything, but generally will be less than the height of the web 
browser.

Example<img src=”images2.jpeg” height=50% width=30%>
        These are explained with an example as shown with html code and output 
in fig 2.40 and 2.41:-

Fig: 2.38

Fig: 2.40

Fig: 2.39

Fig: 2.41
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4. Align defines the alignment of the attached image in contrast to the 
other contents of the webpage. It has different values left, right, top 
and bottom.

 Example for this is as follows
 <img src=”images2.jpeg” align=”Right” >

 

 To increase the space at the top and bottom of an image, use VSPACE 
and HSPACE.

        These are explained with an example as shown with html code and 
output in fig 2.42 and 2.43:-

Similarly other alignments can be performed by changing align attribute 
values.

2.12 Tables:
2.12.1 Creating Tables in HTML: -
 In previous topics we have explained the various aspects in which 
information is defined in the form of sentences and paragraphs. However, the 
information can be defined in the form of columns and rows or tabular form. It 
allows  to manage the information in to multiple rows and columns. The HTML 
tables allow web authors to arrange data like text, images, links, other tables, 
etc. into rows and columns of cells. It makes the webpage attractive. Table 
begins with <Table> tag and ends with</Table>. Table has various attributes 
which will be discussed later. Table tag has various other tags which are 
explained below ;-
1.  Table Heading<TH>.It defines the table headings of a given table. It 

starts with <TH> tag and ends with</TH>tags. It should be defined with 
in the Table Row<TR>.

2. Table Row<TR>.It defines the row in a table. Table heading and table 
data are defined  with in the row which starts with <TR> Tag  and ends 

Fig: 2.43Fig: 2.42

Note:
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with </TR>
3. Table Data <TD>It defines the data of the table. Table data defines the 

information stored in the table. It starts with<TD> data and ends 
with</TD>.

 Let us explain all these tags as shown with html code and output in fig 
2.43and 2.44.

2.12.2 Attributes of Table Tag:-
Border:-  The border attribute defines the width of the table border. It has 

0 value for no border and by default value is 1.
  Example for this is as follows.
  <Table Border="1">
ALIGN:- Align attribute defines the alignment of the table in the browser 

window. It has left, right and center values.
  Example for this is as follows.
  <Table align="Right" Border="1">
BORDERCOLOR: - It defines the color of the border.
  Example for this is as follows.
  <Table BORDER=2 BORDERCOLOR="RED">
WIDTH:-Width defines the width of the table. It can be defined in pixel or as 

a percentage of the web browser window.
  Example for this is as follows.
  <Table WIDTH="35 %">
  It defines the 35% space of the browser.
  <Table WIDTH=500>
  It defines the 500 pixels space of the browser. All the above tags 

are explained with an example shown in fig 2.46 and 2.47

Fig: 2.44 Fig: 2.45
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2.12.3 CELLSPACING is the pixel width between the individual data cells in 
the TABLE. (The thickness of the lines making the TABLE grid). The default 
value  is zero. If the BORDER is set at 0, the CELLSPACING lines will be 
invisible. 
 Example for this is as follows.
<Table Border="2" cellspacing=12> and is explained with an example as shown 
with html code and output in fig 2.48and 2.49

Fig: 2.46

Fig: 2.47
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2.12.4    CELLPADDING is the pixel space between the cell contents and the 
cell border. The default for this property is also zero. This feature is not used 
often, but sometimes comes in handy when you have your borders turned on 
and you want the contents to be "away" from the border a bit for easy viewing. 
CELLPADDING is invisible, even with the BORDER property turned on. 

Example for this is as follows.
<Table  Border=”3” cellpadding=10>These are explained below with html 
code and its output as shown in fig 2.50 & 2.50

Fig: 2.51

Fig: 2.49

Fig: 2.50

Fig: 2.48

2.12.5  COLSPAN and ROWSPAN. Table cells can span across more than 
one column or row. The attributes COLSPAN ("how many across")defines the 
combination of one or more columns together while  ROWSPAN ("how many 
down") indicates how many rows to be combined together.
 Syntax for this is as follows.
 <Table  Border="1" colspan=2>
 <Table  Border="1" rowspan=2>
  These are explained with an example as shown with html code and 
output in fig 2.51 and 2.52:-
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2.12.6   Difference between Colspan  and Rowspan

Fig: 2.53Fig: 2.52

2.12 Table Background:-
 BACKGROUND attribute is used to set the background image in the 
given table.
 The example for this is as follows:-
 <table background=”up.jpeg” border=2> This is explained below  
 with an example.
 These are explained with an example as shown with html code and 
 output in fig 2.54 and 2.55:-
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BGCOLOR:-BGCOLOR is used to set background colour of the table. The 
example used for this attribute is as follows:-
<table bgcolor=”yellow” border=2>This is explained below with an 
example.(Fig. 2.56 and 2.57)

Fig: 2.57Fig: 2.56
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3. A webpage displays a picture. 
What tag was used to display that 
picture?
a. picture  b.mage
c.img   d. src

4. Page designed in HTML is called a
a. Yellow Page b. Web Page
c. Server Page d. Front Page

5.  HTML document is saved using 
____ extension.
a. .htl   b. .html
c. .hml  d. .htnl

6.  Table tag has various other tags, 

these are 

a.  <TR>. b. <TD>.

c. <TH> d. All of the above.

1.  HTML is a Hypertext markup Language which is used to design 
webpage.

2.  HTML codes are defined in Tags.
3. There are two types of element tags: Container and empty tags.
4. Container has both opening and closing tags while empty tags have 

single tag.
5. Web browser is used to see the output of html Program example Google 

chrome, Internet explorer, Firefox, Opera etc..
6. Heading tags can be defined between <H1> to<H6> Tags.
7. User can format his/her text using various tags example. <B>, <U>, <I> 

etc.
8. .html or .htm is the extension of HTML program.
9. Each tag has some attributes which are used to define the properties of 

that tag.
10. There are three types of lists these are ordered, unordered and 

definition lists.
11. Nested Lists are used to represent list with in list.
12. User can connect multiple webpages together with linking.
13. Linking of pages can be done using Anchor<A> tag.
14. Information can be defined in the tabular form, the tag used for this is 

<table>.
15. <IMG> Tag is used to define images in a web page.

1. Multiple Choice Questions:
    1. What should be the first tag in 

any HTML document?
a. <head>  b. <title>
c. <html>  d. <document>

2. What is the correct HTML tag 
for inserting a line break?
a. <br>  b. <lb>
c. <break>  d. <newline>

Exercise 

Points to Remember
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in which whole information about the 

webpage resides.

3. Name a tag which  is an empty 

element that is used to break a line 

and display the proceeding text from 

the next line, without giving any 

space between two lines.

4. Name the list  which have 

information  related to each other 

but their sequence is not important 

6    Short questions:-

1.  What is HTML?

2. What is a Tag?

3. What is <Img> tag. Explain.

4. Name different tags used to create 
a table.

5. Explain Font tag with its 
attributes.

7    Differentiate Between:-

1.  Ordered and Unordered List.

2. Background and BGCOLOR.

3. Colspan and Rowspan.

4. Tag and attribute.

8.  Long questions:-

1. Describe the basic structure of HTML 
in Details.

2. What are the various tags used in 
table .explain with an example. 

3. Explain ordered list with an example.

4. Explain Nesting List with an example.

2  Fills in the Blanks: -

1.  HTML stands for________________.

2. _____________list to represent an 
unorganized list.

3. _____________Tag is used to define 
the elements of a list.

4. ALT stands for_________________.

5. _____________ is the main part of 
the HTML document in which 
whole information about the 
webpage resides.

6. The ___________ contains title that 
identifies the heading of the html 
document.

3  True Or False:-

1.  HTML is a structured Language.

2. Table heading  starts with <TH> tag 
and ends with</TH>tags

3. Align does not defines the alignment 
of the attached image in contrast to 
the other contents of the webpage

4. CELLPADDING is the pixel space 
between the cell contents and the 
cell border.

5. Definition list generally contains the 
definitons of different terms and 
their meaning.

4  FULL FORMS:-

 1.HTML    2.  <B>     3.<I>     4.<U>   
 5.<OL>   6.<UL>   7. <P>    8. <BR>    

 9. SRC   10.<IMG>  11.  <TR>   
 12.<TH>  13<TD> 14. LI  

 15. URL.

5  Very Short Questions

1. Name the tag which is  by the 

beginning and ending tags.

2.  Name the tag  of the HTML document 
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Attribute 

name 

Purpose Syntax  Example 

BGCOLOR This attribute defines the 

background color of the text. 

<Marquee 

BGCOLOR=“COLOR 

NAMEGREEN”> 

<Marquee BGCOLOR 

=“GREEN”> 

DIRECTION This attribute defines the 

direction of the text i.e. 

right,left,up,down. 

<Marquee 

direction=“side”> 

<Marquee 

direction=“Left”> 

HEIGHT Defines the height of the text 

in pixel. 

<Marquee height=“pts.”> <Marquee height=“50”> 

WIDTH Defines the WIDTH of the 

text in pixel. 

<Marquee 

WIDTH=“pts.”> 

<Marquee Width=”20”> 

BEHVIOUR It defines the scrolling if the      

Text with three values  

1.  Scroll : infinitely scrolls 

the text 

2. alternate: moves text left 

then right. 

3.  slide: brings the text from 

left or right of the webpage. 

<Marquee 

behavior=“value”> 

<Marquee 

behavior=“scroll”> 

<Marquee 

behavior=“alternate”> 

<Marquee 

behavior=“slide”> 

 

pix.

pix.



Points to Remember





Answers Key 

Questions 
Multiple 
Choice 

Fill in the 
Blanks 

True or 
False 

Full Form Very Short Answer 

1 
c 

<a> TRUE Anchor tag <A> 

2 
d 

form TRUE Hypertext References Action attribute 

3 
a 

Text area TRUE Uniform resource locator Get method 

4 
c 

Checkbox  Background color Button 

5 
a 

Reset button - Source  

 



4.1 Planning for website.
  
4.2 Web Implementation Guidelines
  
4.3 Aspects related to publishing a website
  
4.4 Important guidelines or checklist.
  
4.5 Project: School Website

Introduction
 We will learn to make small projects and we will also know that how a 
website is planned and launched on internet. There are four stages of planning 
a website viz: goal of site, designing for viewers, work strategy, development of 
subject matter. Similarly there are many stages to put website in use for, 
example, selection of name of Domain, Registration of Domain Name, selection 
of Server, testing the website off-line as well as on-line etc.

4.1 Planning for website.
The website developed by proper planning is always effective. To build a 
website we should first make its planning. If done with proper planning, the 
objective of site would be fulfilled. We communicate through websites. Hence 
we have to decide while planning that what we wish to communicate and by 
which technique. First & foremost purpose of designing a website is to keep in 
mind the goal and target of website. The website should always be built to 
achieve its goal.
4.1.1 The goal of the Site
 Every site has some specific purpose. This purpose guides us what to 
include in the site. User can prepare a detailed and decorative site. But the 
condition is that it must support the purpose of the site. The following facts are 
to be kept in mind while building a site:
 l Purpose of organization.

Objectives of this chapter:

WEB DEVELOPMENT
Chapter 

4
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l important purposes of your site.
l Method to develop the site
l Fulfilling these requirements.
l Working strategy of site to achieve the goal.
l Time of developing the site.
l Time of updating the site.

4.1.2 Designing for the Audience
 After fixing the aim of website, we have to know about nature of viewers of 
the site, which type of people will be hitting it: children, students, advocates, 
doctors or housewives. We have to keep in mind about their expectation from 
your site.
 For example if the designer is building the site for a publisher then the 
viewer's certainly would be students, children, teachers, professors and other 
intellectuals. In such a case the site will be designed according to their interest 
and expectations.
4.1.3 Strategy
 When the designer has decided to build a particular site, we will have 
to think about its work-strategy. The mode of works to carry out for 
achieving the goal is called work-strategy.  Many kinds of information can 
be included in the website.
 l Text information
 l Audio or Voice information
 l Video information
 A simple website is good and impressive. In other words it should not be 
complicated.
4.1.4 Contents
 After finalizing above jobs we now need the contents of site to enter. The 
contents of the site supplies all the important information to the viewer, hence 
the contents should be at proper place and arranged systematically. If there 
are links in a sequence, then it is easier to search the required information.
4.2 Web Implementation Guidelines
 After making complete and proper planning and deciding about 
information (contents) and links we have to work for its implementation part. 
We probably know that the content of the website is its most important aspect, 
but it's also very important that its intended audience are able to find it, and 
that visitors to our site can quickly locate the information they are seeking. It's 
also a good idea to check that it's thoroughly optimized to attract new visitors 
and track their activities.
 Selection of Domain Name, Registration of Domain, Selection of server 
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and managing the site etc. are under the Web Implementation Plan.

4.2.1 Choosing Domain Name
 Domain name is the address of your site .Choose a domain name that 
is brief, easy to remember, and suited to the content of your website. Some 
common top-level domains include .com, .edu, .org, and .net, which stand 
for commercial, education, organization, and network respectively. It should 
not include hyphens. Maximum numbers of letters included in it can be 63.
4.2.2 Registering Domain Name
 After deciding about the Domain Name, we have to register it. Designer 
can register the site through the service provider. Service provider asks to fill a 
form and also charges fee for its registration. After filling the form it is verified 
whether the Domain name provided by the designer is free and is not already 
registered by anyone else. If the name is available then designer gets the 
confirmation message about registration through email.
4.2.3 Choosing a Server
 To put the site in practice we have to choose the server or host. It is very 
important task Designer can buy or hire the server where the site is to remain 
permanent. In the web world the role of server is very important. Such a 
specific server is named Web server. Whenever designer opens any site on the 
browser, it connects to the concerned server. Securing the bandwidth 
necessary to keep the website running smoothly. Bandwidth is the amount of 
data transferred within a given time period.
Designer may need to buy more bandwidth as the website grows or else the 
visitors may experience lag, which could drive them away from the website. 
Many hosts also provide software aid in building the website.
4.2.4 Organizing Web page
 If a person cannot find what they are looking for on the website within 30 
seconds, there is a good chance they will leave and never return. Organizing 
the website into specific sections and then providing links to those sections at 
the top of each page is an effective and simple way to make the  website easy to 
navigate. The Webpage should be beautifully organized. So that it gives a 
balanced look. The size of the page is an important point in organizing 
webpage. The following points must be kept in mind while designing a 
webpage.
 1.  Size of a web page should not be more than two screens. If we have to 

use a longer page, the establish internet link through bookmark. 
 2.  If the document is longer than one screen then show only a part of it to 
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the viewers and remaining part maybe shown only on their demand/ 
requirement.

4.2.5 Look
 Webpage should have a fine look so that one is attracted to read it. In a 
webpage with a good look designer should insert links graphics, animation, 
sound and video clips. The various contents in the webpage should give an 
impression of diversity and a beautiful view. Usage of proper font size/colour, 
background colour, table, graph etc. gives a good look to the site.
4.2.6 Validate the code.
  Validate the HTML, CSS, XHTML, JavaScript, and XML codes to ensure 
that the website has clean code and function as intended for visitors. There are 
several programs available online that validate each type of code.
4.2.7 Offline Testing
 After designing all the webpages it is tested on the browser. No internet 
connection is required for this test that is why it is named as offline test. In 
offline test first of all home page is opened in different browser. Then we check 
all the linked pages one by one. Designer should ascertain it here that all pages 
have a good appearance. The website should be thoroughly tested to confirm 
that the design and page structure are displayed as intended. Specifically, 
view the website with the most popular browsers, including Chrome, Firefox, 
Internet Explorer, Opera, and Safari, as those browsers are used by the 
majority of people who are browsing the Internet. 
4.2.8 Uploading the Site
 To make the site available to all the viewers on the internet is called 
Upload. To transfer. 
 The webpages to the "Host" we need File Transfer Protocol (FTP) client. 
For this purpose first of all we set FTP programmer as Cute FTP. Then upload 
the file after coming online. The copy of the website on computer is called the 
local version, and the copy on the web host is called the production version.
4.2.9 Online Testing
 When the site is uploaded online, next step is to test it online. Make the 
internet connection, open the browser, and type URL of the site. Check that all 
the links of the site are working property.
4.2.10 Using SEO-friendly code. 
 Utilize both Meta and ALT tags to ensure that the website not only 
appears in user searches but that pertinent keywords from the content of the 
website are displayed. Doing so will more likely attract searchers' interests and 
will facilitate more visits to the website. ALT tags are merely a written 
description to go along with the pictures on the website, and so they are 
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necessary to tell search engines and searchers what kind of pictures are there 
on the website.
4.2.11 Installing website analytics
 The statistics will enable  to monitor  the number of visits  website 
receives, the amount of time visitors stay, the average number of page views 
for each visitor, and many other useful statistics. Making use of such 
software will enable  to make adjustments to the website to increase its 
effectiveness.
4.3 Some important aspects related in publishing website 
4.3.1 SEO  
 SEO means search engine optimization. Search engine optimization is a 
methodology of strategies, techniques and tactics used to increase the amount 
of visitors to a website by obtaining a high-ranking placement in the search 
results page of a search engine including Google, Bing, Yahoo and other search 
engines.
 SEO helps to ensure that a site is accessible to a search engine and 
improves the chances that the site will be found by the search engine. SEO is 
typically a set of practices that webmasters and Web content producers follow 
to help them achieve a better ranking in search engine results.
4.3.2 Social media marketing (SMM) 
 SMM is a form of Internet marketing that utilizes social networking 
websites as a marketing tool. The goal of SMM is to produce content that users 
will share with their social network to help a company increase brand exposure 
and broaden customer reach. 
 One of the key components of SMM is social media optimization (SMO). 
Like search engine optimization (SEO), SMO is a strategy for drawing new and 
unique visitors to a website. SMO can be done in two ways: adding social media 
links to content, sharing buttons or promoting activity through social media by 
updating statuses or tweets, or blog posts.
 SMM helps a company get direct feedback from customers (and potential 
customers) while making the company seem more personable. SMM became 
more common with the increased popularity of websites such as 
Twitter,Facebook, Myspace, LinkedIn, and YouTube.
4.4  Some important guidelines or checklist which must be noted while 
publishing website.
4.4.1 Page Content
1. Spelling and grammar, paragraphs, headers, lists, and other formatting 

should be correct.
2. Company contact details are accurate throughout the website.

69



3. Images and audio and videos are in the correct places, formatted and 
working on all devices.

4.4.2Design
  Take the necessary steps to ensure that the site design is pixel perfect. If 
designer has a responsive website. It needs to check the design across all 
devices. The site should be looking good not just on an office desktop, but also 
on laptops, tablets, and mobile phones.
4.4.3 Functionality
  Take some time to test and validate all of the different features on the 
website. Lead generation forms, social sharing, should work flawlessly across 
the website such as:-
 1. Thank-you message or page displays after form is submitted.

2. Company logo is linked to the homepage.
3. Load time for site pages is optimized.

4.4.4 SEO
 Take some time to ensure that the website has been given a solid 
foundation for SEO success. From site architecture and content to metadata 
sitemaps, do not leave any stone unturned such as: 
 1. Pages have unique page titles (fewer than 70 characters, 

includes keywords).
2. Pages have keywords (fewer than 10, all words appear in page 

copy).
3. Spelling and grammar are correct in all information.
4. Alt tags have been added to every image.

4.4.5 Security & Backups
 Designer can prevent loss of data and protect against malware and other 
damages by properly setting up site security and regular backups.
 1. 24 x 7 monitoring scripts are installed.

2. A copy of the final website has been made for backup purposes.
3. Ongoing copies of the website are being created and stored on a 

regular basis.
4. Passwords and other website credentials are stored in a secure 

database.
4.4.6 Compliance
 Finally, make sure the website complies with any applicable laws and 
regulations. Internet law can be hard, and each industry has its own set of 
rules to follow.  Following are a few rules one needs to know about:
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1. Web pages offer accessibility for users with disabilities.
2. Terms and privacy policies are visible to website visitors.
4.3 Project

Project: School Website
We have learnt in details, about planning uploading and online testing 

etc of a website. Let us now build a project on the subject of "School 
Website".

For building a project first of all a source file is created in notepad. It is 
saved as: with ..html extension. Finally it is run on internet explorer.

There are common tags used in building this project, which we have 
studied in previous chapters. This project contains one homepage and eight 
web pages. All the eight webpages are linked to home page.

Home page is always the first page of the  website. This page contains 
all the information available on the site.
 Now we are able to make a project in html related to a school ,So that we 
can able to implement all the concepts which we have discussed in this and 
previous chapters. Let us make a website of a school.
This is the home page of our website. As shown in fig.4.1

Fig 4.1
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Code for this page is as follows in fig 4.2

Fig 4.2
The first Link available in the website is facilities available and the code 
and output for this is shown in fig 4.3 and 4.4

Fig. 4.3 
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Fig 4.4
The second link is admission form which has following output and code as 
shown in Fig. 4.5 and 4.6(a)  and 4.6 (b)  

Fig. 4.5
And the code for this form is as follows. Fig 4.6
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Fig 4.6 (a)

Fig 4.6(b)
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The next link is for faculty details the output and its code is defined below in   
 fig 4.7and 4.8:-

Fig 4.7
The code for this is as follows

Fig 4.8
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The next link is for house details the output in figure 4.9 and its code is 
defined below inn fig. 4.10 (a), 4.10 (b) and 4.11, 4,12.
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Fig 4.9

Fig 4.10(a) Fig 4.10(b)
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   Fig 4.11                                                       Fig. 4.12

The next available link is photo gallery as shown in figure 4.13 and  the 
output and code for this webpage as shown in fig 4.14. 

 Fig 4.13       Fig 4.14        
The next available link is Other helpful websites the output as shown in figure 
4.15 and code for this webpage is as shown in fig.4.16 
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   Fig 4.15                Fig 4.16
The next available link is query/suggestion form the output and code for 
this webpage is as shown in fig. 4.17, 4.18.

Fig.4.17
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Fig 4.18
The next  and last available link is locate us the output as shown in figure 
4.19 and code for this webpage is as fig. 4.20:-

Fig. 4.19 



Fig 4.20
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Points to Remember

1. Before deciding about the server we should register the domain 
name.

2. The needs of viewers should be kept in mind while designing a 
website.

3. You can establish your own server or can hire a space for it from 
any company or organization.

4. After designing all pages they are tested off line.
5. Site is uploaded with the help of FTP (File Transfer Protocol).
6. After successful uploading, site in tested online.
7. First page of a site is the home page, all other pages of site are 

linked with home
8. Bandwidth is the amount of data transfer you are allowed 

within a given time period.
9. Test your website in a variety of web browsers.  
10. Search engine optimization is a methodology of strategies, 

techniques and tactics used to increase the amount of visitors 
to a website 
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1. Multiple Choice Questions:

1.  There are four stages of planning a 
website.

 a.  Goal of a site.
 b.  Designing for viewers.
 c.  Work strategy. And   

 development of subject matter.
 d. All of the above.
2.  A good look of a webpage depends 

upon
 a. Font size/colour.
 b. background colour
 c. Table and graphics.
 d. All of the above.
3.  No internet connection is needed in
 a. Offline testing.
 b. Online testing.
 c. Both of the above.
 d. None of these.
4.  SEO means  
 a. Search engine optimization.
 b. System engine optimization.
 c. Syncronized engine   

  optimization.
 d. None of the above.
5.  SMM Stands for
 a. Social media marketing.
 b. Science media marketing.
 c. System macro media.
 d. None of the above.

2. Fill in the Blanks:

1. While planning to build a site, decision 
about......f site is taken at the end.

2. ..............is the address of your site.

3. After deciding about domain name next 
step is ..............the domain name.

4. ...............test can be done without the 
internet.

5. The very first page of any website is 
called as...................

Exercise 3. True or False:

1. There is no link of other pages with the 
home page

2. Address of site ends with .com, .org, .net 
etc.

3. Off line testing of a site should be done 
on a single browser only.

4. To send the webpages to host, we need 
FTP client.

5. During online testing of a site your 
computer should be connected to the 
internet.

Give the full names of

 1. IP 2. FTP 3. URL

4.   Very Short Answer type Questions: 

1.   Which is the address of your site .

2. The copy of the  website on  computer is 
called the _______ version, and the copy 
on the web host is called the 
_________version.

3. What helps a company get direct 
feedback from customers.

4. What is necessary to check  all of the 
different features on the website.

5. How can Designer   prevent loss of data 
and protect against malware and other 
damages. 

5. Short Answer type Questions:

1. Describe the important points to fix 
the purpose of a site.

2. What do you mean by Domain Name?

3. What is role of server in world of 
internet?

4. What points are to be taken care of 
while designing a webpage?

5. What do you mean by offline testing?



6. Long Answer type Questions:

1. Write the different steps for planning a 
website?

2. Describe the necessary direction for 
implementing a website.

3. What is difference between offline 
and online testing.

4. What is SEO?

5. What is SMM?
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Introduction
 When documents and images are printed, these are "published." Before 
computers became common place, the publishing process required large print 
presses that copied and duplicated pages. In order to print images and words 
on the same page, the text and graphics would have to be printed separately, 
cut out, placed on a single sheet, taped in place, then copied and printed. 
Fortunately, computers with graphical user interfaces have enabled desktop 
publishing, which allows this process to be done electronically.

5.1 Desktop publishing:

 Any time we use a computer to create a printable document, it can be 
considered desktop publishing. Desktop publishing programs can be used to 

Objectives of this chapter:

Desktop Publishing
Chapter 

5
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create books, magazines, newspapers, flyers, pamphlets, and many other 
kinds of printed documents. Word processing programs like Microsoft Word 
can be used for basic desktop publishing purposes.

 Complete desktop publishing involves the combination of typesetting 
(choosing fonts and the text layout), graphic design, page layout (how it all fits 
on the page), and printing the document. However desktop publishing can also 
be as simple as typing and printing a school paper. In order to desktop publish, 
all we need is a computer, monitor, printer, and software that can create a 
printable document. While that might cost more than a pen and paper, it 
certainly is cheaper than a printing press.

5.1.1 Definition:
Desktop publishing is the process of using a computer and specific types of 
software to combine text, images and artwork to produce documents 
properly formatted for print or visual consumption.
5.1.2  Desktop Publishing Opened Visual Communication To All
 Desktop publishing isn't limited to professionals. With the advent of 
desktop publishing software and affordable desktop computers, a wide range 
of people, including non-designers and others without graphic design 
experience, suddenly had the tools to become desktop publishers.
  Freelance and in-house graphic designers, small business owners, 
secretaries, teachers, students and individual consumers do desktop 
publishing. 
 Non-designers can create visual communications for commercial digital 
printing, printing on a printing press, and for desktop printing at home or in the 
office.
 Although desktop publishing encompasses everything from the initial 
design to printing and delivery of the finished product, the core parts of 
desktop publishing are the page layout, text composition and the prepress or 
digital file preparation tasks.
5.2  Desktop-publishing softwares
 The primary software used in desktop publishing is page layout software 

and web design software  Graphics software, including drawing software, a .
photo editor and word processing software, are also important tools of the 
graphic designer or desktop publisher. The list of available software is lengthy, 
but some software is seen on just about everyone's must-have list depending 
on what they are trying to accomplish. 
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5.2.1 Page Layout Software for Printing
l· Adobe InDesign
l· PagePlus Series from Serif
·  QuarkXpressl

5.2.2 Page Layout Software for Office
·  Microsoft Office Suitel

·  Apple iWork Suitel

5.2.3 Graphics Software
·  Adobe Illustratorl

·  Corel Drawl

·  Inkscape l

5.2.4 Photo Editing Software
·  Adobe Photoshopl

·  Corel PaintShop Prol

5.2.5 Web Design Software
·  Adobe Dreamweaver CCl

·  Adobe Musel

5.3 Word Processing vs. Desktop Publishing
 Both word processing and desktop publishing are similar in many ways 
but different in areas that cover the publication of documents.
The similarities between the two are:
  · Both  deal with text that can be formatted.l

 ·  Both can work with tables and pictures.l

 ·  Both  have many similar features like WordArt, Clip Art, and l

  text styles.
The differences between the two are:
· Word processing involves creation, editing, and printing of text while 
desktop publishing involves production of documents that combine text 
with graphics.
· Word processing is difficult to layout and design as compared to desktop 
publishing. Thus, desktop publishing is used to work on things like 
newsletters, magazines, adverts, and brochures where layout is important. 
Word processing documents are common for simple memos, letters, 
manuscripts, and resumes.
5.4  WYSIWYG Feature:
 Pronounced WIZ-zee-wig. Short for what you see is what you get. A 
WYSIWYG  is one that enables us to see on the  application display screen
exactly what will appear when the document is printed. A  WYSIWYG  is a 
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system in which content (text and graphics) can be edited in a form closely 
resembling its appearance when printed or displayed as a finished product, 
such as a printed document, web page, or slide presentation. WYSIWYG is 
especially popular for desktop publishing
 With desktop publishing, we can increase productivity, minimize 
production cost, enhance the appearance of our documents, improve the level 
of creativity, reduce the time taken for printing and produce customized 
documents. The best part about DTP is that we can create professional-looking 
documents, without the need for graphic designer.
5.5 Graphics
 A graphic is an image or visual representation of an object. Therefore, 
computer graphics are simply images displayed on a computer screen. 
Graphics are often contrasted with text, which is comprised of characters, 
such as numbers and letters, rather than images.
 Computer graphics can be either two or three-dimensional. Early 
computers only supported 2D monochrome graphics, meaning they were black 
and white (or black and green, depending on the monitor). Eventually, 
computers began to support color images. While the first machines only 
supported 16 or 256 colors, most computers can now display graphics in 
millions of colors.
There are two main types of 2D graphic:
 ; · Bitmap or Raster graphicsl

 ·  Vector graphicsl

5.5.1 Bitmap or raster graphics
 Bitmap graphics consist of many tiny dots called pixels. It is possible to 
edit each individual pixel using bitmap graphics software like Adobe 
Photoshop .
Examples of bitmap graphics are a digital photograph or a scanned image.
 The amount of detail we can draw depends on the number of pixels per 
square inch (PSI). Since the computer has to store information about every 
single pixel in the image, the file size of a bitmap graphic is often quite large. 
When we resize a bitmap graphic, it tends to lose its quality. 
5.5.2 Vector graphics
Vector graphics are based on control points which are connected by lines and 
curves called vector paths or vectors. Vector paths can be used to make shape 
objects. It is possible to edit each shape object separately, for example, to 
change the shape, outline type (stroke), fill, size or position.
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Vector graphics software includes Adobe Illustrator and CorelDRAW.
When a vector graphic is resized, it doesn't lose quality. This is because the 
software works out the new relationships between control points and redraws 
the image at the new size. Vector graphics do not store information about each 
pixel so file size does not depend on image size. Instead it depends on how 
much detail is in the image.

 
 
3D graphics started to become popular 
in the 1990s, along with 3D rendering 
software such as CAD and 3D animation 
programs. By the year 2000, many video 
games had begun incorporating 3D 
graphics, since computers had enough 
processing power to support them. Now 
most computers now come with a 3D 
video card that handles all the 3D 
processing. This allows even basic home 
systems to support advanced 3D games 
and applications.

5.6 Margins
 A margin is the area between the 
main content of a page and the page 
edges. The margin helps to define where 
a line of text begins and ends. A page to 
include top, Bottom, Left and Right 
margin as shown in fig 5.2.
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The default margins are usually defined as one inch on all sides. However, 
depending on the requirement, the margins may vary. These margins create a 
frame around the content of the page so that the text does not run all the way 
to the edges. The white space along the edges of the document makes the page 
look cleaner and the text is easier to read. 

5.6.1 Gutter position
 A gutter margin setting adds extra space to the side margin or top margin 
of a document that we plan to bind. A gutter margin helps ensure that text isn't 
hidden by the binding.

5.7 Fonts
 A font is a set of printable or displayable text character s in a specific style 
and size or we can say that a font is a specific typeface of a certain size and style. A 
typeface is a set of characters of the same design. These characters include 
letters, numbers, punctuation marks, and symbols. Some popular typefaces 
include Arial, Helvetica, Times, and Verdana. While most computers come with a 
few dozen typefaces installed, there are thousands of typefaces available. Because 
they are vector-based (not bitmaps), typefaces can be scaled very large and still 
look sharp. The term "typeface" is often confused with "font," which is a specific 
size and style of a typeface. For example, Verdana is a typeface, while Verdana 10 
pt bold is a font. It's a small difference, but is good to know.
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5.8 Printer

 A printer is an external output device that takes data from a computer and 

generates output on a paper in the form of graphics / text.

There are two types of printers.

· Impact Printers

· Non-Impact Printers

5.8.1 Impact printers

 An impact printer  has a head that contains pins to make contact with the 

paper. It usually forms the print image by striking its pins on a inked ribbon 

against the paper . Following are some examples of impact printers.

5.8.1.1 Dot-Matrix Printers

 The dot-matrix printer uses print heads containing from 9 to 24 pins. These 

pins produce patterns of dots on the paper to form the individual characters. The 

24 pin dot-matrix printer produces more dots that a 9 pin dot-matrix printer, 

which results in much better quality and clearer characters. The general rule is: 

the more pins, the clearer the letters on the paper. The pins strike the ribbon 

individually as the print mechanism moves across the entire print line in both 

directions, i-e, from left to right, then right to left, and so on. The user can produce 

a color output with a dot-matrix printer (the user will change the black ribbon with 

a ribbon that has color stripes). Dot-matrix printers are inexpensive and typically 

print at speeds of 100-600 characters per second.
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                                          Fig 5.6 Dot Matrix Printer
5.8.1.2 Daisy-wheel Printers
 In order to get the quality of type found on typewriters, a daisy-wheel impact 
printer can be used. It is called daisy-wheel printer because the print mechanism 
looks like a daisy; at the end of each “Petal” is a fully formed character which 
produces solid-line print. A hammer strikes a “petal” containing a character 
against the ribbon, and the character prints on the paper. Its speed is slow 
typically 25-55 characters per second.
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Note:

dot marix printer and daisy wheel printer comes in the category of 
character- at- a- time printer.

Fig 5.7 Daisy Wheel Printer

5.8.1.3  Line Printers
In business where enormous amount of material are printed, the character-at-
a-time printers are too slow; therefore, these users need line-at-a-time 
printers. Line printers, or line-at-a-time printers, use special mechanism that 
can print a whole line at once; it can typically print the range of 1,200 to 6,000 
lines per minute. Drum, chain, and band printers are line-at-a-time printers.
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                                          Fig 5.8

                                          Fig 5.9

5.8.2 Non-Impact Printers
 Non-impact printers do not use a striking device to produce characters on 
the paper; and because these printers do not hammer against the paper its much 
quieter. Following are some non-impacted printers.

5.8.2.1 Ink-jet printers
 Ink-jet printers work in the same fashion as dot-matrix printers in the form 
images or characters with little dots. However, the dots are formed by tiny droplets 
of ink. Ink-jet printers form characters on paper by spraying ink from tiny nozzles 
through an electrical field that arranges the charged ink particles into characters 
at the rate of approximately 250 characters per second. The ink is absorbed into 
the paper and dries instantly. Various colors of ink can also be used.

 One or more nozzles in the print head emit a steady stream of ink drops. 
 Droplets of ink are electrically charged after leaving the nozzle. The 
droplets are then guided to the paper by electrically charged deflecting plates 
[one plate has positive charge (upper plate) and the other has negative charge 
(lower plate)]. A nozzle for black ink may be all that's needed to print text, but 
full-color printing is also possible with the addition of needed to print text,  
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                                          Fig 5.10

three extra nozzles for the cyan, magenta, and yellow primary colors. If a 
droplet isn't needed for the character or image being formed, it is recycled 
back to its input nozzle.
 Several manufacturers produce color ink-jet printer. Some of these 
printers come with all their color inks in a cartridge; if we want to replace on 
color, we must replace all the colors. Other color ink-jet printers allow us to 
replace ink individually. These printers are a better choice if user uses one 
color more than other colors. These printers produce less noise and print in 
better quality with greater speed.
5.8.2.2 Laser printers
 A laser printer works like a photocopy machine. Laser printers produce 
images on paper by directing a laser beam at a mirror which again directs the 
beam onto a drum. The drum has a special coating on it to which toner (an 
ink powder) sticks. Using patterns of small dots, a laser beam conveys 
information from the computer to a positively charged drum to become 
neutralized. From all those areas of drum which become neutralized, the 
toner detaches. As the paper rolls by the drum, the toner is transferred to the 
paper printing the letters or other graphics on the paper. A hot roller bonds 
the toner to the paper.

 Laser printers use buffers that store an entire page at a time. When a 
whole page is loaded, it will be printed. The speed of laser printers is high and it 
print quietly without producing much noise. Many home-use laser printers can 
print eight pages per minute, but faster and print approximately 21,000 lines 
per minute, or 437 pages per minute (if each page contains 48 lines). When high 
speed laser printers were introduced they were expensive. Developments in the 
last few years have provided relatively low-cost laser printers for use in small 
businesses.
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Points to Remember

   1. In order to desktop publish; all we need is a computer, monitor, 
printer, and software that can create a printable document.

2. Desktop publishing hardware and software is also used to design and 
produce web pages.

3. The primary software used in desktop publishing is page layout 
software and web design software.

4. Both word processing and desktop publishing are similar in many 
ways but different in areas that cover the publication of documents.

5. A graphic is an image or visual representation of an object.
6. A  margin is the area between the main content of a page and the page 

edges.
7. A printer is an external output device that takes data from a computer 

and generates output in the form of graphics / text on a paper

Exercise 
1. Multiple Choice Questions:

1)  Programs that can be used to create 
books, magazines, newspapers, flyers, 
pamphlets, and many other kinds of 
printed documents.
 a. Desk Publishing
 b. Desk Top Publishing
 c. Top Publishing
 d. Publishing
2) That enables us to see on the display 
screen exactly what will appear when the 
document is printed.
 a. WYSWJKI
 b. WKSWUG
 c. WUSIWUG
 d. WYSIWYG
3) A  printer  that works like a photocopy 
machine
 a. Laser
 b. InkJet
 c. Line
 d. Drum

4) ______ is a visual representation of 
objects
 a. Charts
 b. Graphics
 c. Frames
 d. Fonts
5) Printer that print image by pressing an 
inked ribbon against the paper using a 
hammer or pins.
 a. Ink-jet
 b. Impact
 c. Non impact
 d. Laser 

Fill in the banks

1) Arial, Helvetica, Times, and 
Verdana etc. are examples of_____ 
and they have same ___________.

2) A Gutter  margin setting adds 
extra space to the ____ margin or  
_____  margin of a document that 
we plan to bind.
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3) In web pages the content is 
_______, not designed for ____.

4) Laser printers use ______ that 
stores an ________ at a time.

True/False
1) DTP stands for Desk Top 

Publishing.
2) Desktop publishing hardware and 

software is also used to design and 
produce web pages.

3) In Ink-Jet Printer, the ink cannot 
be absorbed into the paper and 
dries instantly.

4) The dot-matrix printer uses print 
heads containing from 19 to 124 
pins.

Very short  Answers Type Questions
1) Which printer can typically print 

the range of 1,200 to 6,000 lines 
per minute?

2) Which printer can be either two or 
three-dimensional.

3) Which printer has a special coating 
on it to which toner (an ink 
powder) sticks?

4) A set of characters of the same 
design is called as .....?

5) The area between the main 
content of a page and the page 
edges is called as ....? 

Short Answer type Questions
1) What is Desktop Publishing?
2) What are the various types of 

printers?
3) What is margin?
4) What do you mean by Gutter 

Position?
5) What are Graphics?
6) Explain WYSIWYG feature.

Long Answer type questions 

1) What is the difference between 
Vector Graphics and Bitmap 
Graphics?

2) Describe Desktop Publishing & 
List any five software used for 
Desktop Publishing. 

3) What is the difference between 
Impact and Non-Impact printers?

4) What are non-impact printers 
explain laser & inkjet printers. 
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6.1  Definition of operating system

6.2  Types of operating systems

6.3  Difference between DOS and Windows Operating System 

    6.4  Linux 

    6.5  Computer Security
 

Introduction:
 An Operating System (OS) is an interface between computer user and 
computer hardware. An operating system is software which performs all the 
basic tasks like file management, memory management, process 
management, handling input and output, and controlling peripheral devices 
such as disk drives and printers.
 Some popular Operating Systems include Linux, Windows, OS X, VMS, 
OS/400, AIX, z/OS, etc.

6.1 Definition of operating system
 An operating system is a program that acts as an interface between the 
user and the computer hardware and controls the execution of all kinds of 
programs.

Fig 6.1 Operating System

Objectives of this chapter:
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6.1.1Services provided by operating System
 An Operating System provides services to both the users and to the 
programs.

l It provides programs an environment to execute.
l It provides users the services to execute the programs in a    

  convenient  manner.
Following are a few common services provided by an operating system ?

l Program execution
l I/O operations
l File System manipulation
l Communication
l Error Detection
l Resource Allocation
l Protection

6.1.1.1 Program execution
 Operating systems handle many kinds of activities from user 
programs to system programs like printer spooler, name servers, file server, 
etc. Each of these activities is encapsulated as a process.
 A process includes the complete execution context (code to execute, 
data to manipulate, registers, OS resources in use). Following are the major 
activities of an operating system with respect to program management ?

l Loads a program into memory.
l Executes the program.
l Handles program's execution.
l Provides a mechanism for process synchronization.
l Provides a mechanism for process communication.
l Provides a mechanism for deadlock handling.

6.1.1.2    I/O Operation
 An I/O subsystem comprises of I/O devices and their corresponding 
driver software. Drivers hide the peculiarities of specific hardware devices 
from the users.
 An Operating System manages the communication between user 
and device drivers.

l I/O operation means read or write operation with any file or any 
specific I/O device.

l Operating system provides the access to the required I/O device 
when required.



6.1.1.3   File system manipulation
 File manipulation refers to wide variety of operations which are available 
and allow us to delete ,copy, move. As we know a file represents a collection of 
related information. Computers can store files on the disk (secondary storage), 
for long-term storage purpose. Examples of storage media include magnetic 
tape, magnetic disk and optical disk drives like CD, DVD. Each of these media 
has its own properties like speed, capacity, data transfer rate and data access 
methods.
 A file system is normally organized into directories for easy navigation 
and usage. These directories may contain files and other directions. Following 
are the major activities of an operating system with respect to file                  
management ?

l Program needs to read a file or write a file.
l The operating system gives the permission to the program for 

operation on file.
l Permission varies from read-only, read-write, denied and so on.
l Operating System provides an interface to the user to 

create/delete files.
l Operating System provides an interface to the user to 

create/delete directories.
l Operating System provides an interface to create the backup of file 

system.

6.1.1.4   Communication
 In case of distributed systems which are a collection of processors that 
do not share memory, peripheral devices, or a clock, the operating system 
manages communications between all the processes. Multiple processes 
communicate with one another through communication lines in the network.
 The OS handles routing and connection strategies, and the problems of 
contention and security. Following are the major activities of an operating 
system with respect to communication ?

�l Two processes often require data to be transferred between them
l Both the processes can be on one computer or on different 

computers, but are connected through a computer network.
l Communication may be implemented by two methods, either by 

Shared Memory or by Message Passing.
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6.1.1.5     Error Detection
 Errors can occur anytime and anywhere. An error may occur in CPU, in 
I/O devices or in the memory hardware. Following are the major activities of an 
operating system with respect to error Detection ?

l The OS constantly checks for possible errors.
l The OS takes an appropriate action to ensure correct and     

  consistent computing.
6.1.1.6    Resource Management
 In case of multi-user or multi-tasking environment, resources such as 
main memory, CPU cycles and files storage are to be allocated to each user or 
job. Following are the major activities of an operating system with respect to 
resource management ?

l It acts like a resource manager. The OS manages all kinds of 
resources using schedulers.

l CPU scheduling algorithms are used for better utilization of 
CPU.

6.1.1.7    Protection
 Considering a computer system having multiple users and concurrent 
execution of multiple processes, the various processes must be protected from 
each other's activities.
 Protection refers to a mechanism or a way to control the access of 
programs, processes, or users to the resources defined by a computer system. 
Following are the major activities of an operating system with respect to 
protection ?

l The OS ensures that all access to system resources is    
  controlled.

l The OS ensures that external I/O devices are protected from 
  invalid access attempts.

l The OS provides authentication features for each user by means 
  of passwords.

6.2     Types of Operating Systems
 Operating systems are there from the very first computer generation 
and it keep evolving with time. In this chapter, we will discuss some of the 
important types of operating systems which are most commonly used.

6.2.1   Batch operating system
 The users of a batch operating system do not interact with the computer 
directly. Each user prepares his job on an off-line device like punch cards and 
submits it to the computer operator. To speed up processing, jobs with similar 
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needs are batched together and run as a group. The programmers leave their 
programs with the operator and the operator then sorts the programs with 
similar requirements into batches.
The problems with Batch Systems are as follows ?

l Lack of interaction between the user and the job.
l CPU is often idle, because the speed of the mechanical I/O 

devices is slower than the CPU.
l Difficult to provide the desired priority.

6.2.2   Time-sharing operating systems
 Time-sharing is a technique which enables many people, located at 
various terminals, to use a particular computer system at the same time. 
Time-sharing or multitasking is a logical extension of multiprogramming. 
Multiple jobs are executed by the CPU by switching between them, but the 
switches occur so frequently. Thus, the user can receive an immediate 
response. Computer systems that were designed primarily as batch systems 
have been modified to time-sharing systems. Advantages of Timesharing 
operating systems are as follows ?

l Provides the advantage of quick response.
l Avoids duplication of software.
l Reduces CPU idle time.
Disadvantages of Time-sharing operating systems are as follows ?
l Problem of reliability.
l Question of security and integrity of user programs and data.
l Problem of data communication.

6.2.3   Distributed operating System
 Distributed systems use multiple central processors to serve multiple 
real-time applications and multiple users. Data processing jobs are 
distributed among the processors accordingly.
 The processors communicate with one another through various 
communication lines (such as high-speed buses or telephone lines). These are 
referred as loosely coupled systems or distributed systems. Processors in a 
distributed system may vary in size and function. These processors are 
referred as sites, nodes, computers, and so on.
The advantages of distributed systems are as follows ?

l With resource sharing facility, a user at one site may be able to 
use the resources available at another.

l Speedup the exchange of data with one another via electronic 
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mail.
l If one site fails in a distributed system, the remaining sites can 

potentially continue operating.
l Better service to the customers.
l Reduction of the load on the host computer.
l Reduction of delays in data processing.

6.2.4    Network operating System
 A Network Operating System runs on a server and provides the server the 
capability to manage data, users, groups, security, applications, and other 
networking functions. The primary purpose of the network operating system is 
to allow shared file and printer access among multiple computers in a network, 
typically a local area network (LAN), a private network or to other networks.
 Examples of network operating systems include Microsoft Windows 
Server 2003, Microsoft Windows Server 2008, UNIX, Linux, Mac OS X, Novell 
NetWare, and BSD.
 The advantages of network operating systems are as follows ?

l Centralized servers are highly stable.
l Security is server managed.
l Upgrades to new technologies and hardware can be easily 

integrated into the system.
l Remote access to servers is possible from different locations and 

types of systems.
The disadvantages of network operating systems are as follows ?
l High cost of buying and running a server.
l Dependency on a central location(server) for most operations.
l Regular maintenance and updates are required.

6.2.5    Real Time operating System
 A real-time system is defined as a data processing system in which the 
time interval required to process and respond to inputs is so small that it 
controls the environment. The time taken by the system to respond to an input 
and display of required updated information is termed as the response time. So 
in this method, the response time is very less as compared to online 
processing.
 Real-time systems are used when there are rigid time requirements on 
the operation of a processor or the flow of data. A real-time operating system 
must have well-defined, fixed time constraints, otherwise the system will fail. 
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For example, Scientific experiments, medical imaging systems, industrial 
control systems, weapon systems, robots, air traffic control systems, etc.

6.3   Difference between DOS And Windows Operating System
 Disk Operating System abbreviated as DOS is a product of Microsoft 
Corporation released in 1981 and it comes as part-and-parcel with Microsoft 
Windows operating system.To get to DOS prompt and give commands for 
performing tasks on files and directories, 
 Click Start > Run… and type command or cmd and press ENTER.
 Windows is a series of most popular operating systems developed by 
Microsoft for use on personal computers. First edition of Windows that runs 
on MS-DOS 5.0 was released in 1985, as a 16-bit OS. Of all the editions of 
Windows OS released by Microsoft Corporation from 1985 till date, the 
popular ones include Windows 98, Windows 2000 Professional, Windows XP, 
Windows Vista and Windows 7,windows8,window10 Coming to differences, 
here are 5 basic ones that differentiate DOS and Windows:

6.4 Linux
Linux is one of popular version of UNIX operating System. It is open source 
as its source code is freely available. It is free to use. Linux was designed 
considering UNIX compatibility. Its functionality list is quite similar to that 
of UNIX.
6.4.1   Basic Features
 Following are some of the important features of Linux Operating 
System.

l Portable : Portability means software can works on different 
types of hardware in same way. Linux kernel and application 
programs supports their installation on any kind of hardware 
platform.

BMQ U gl bmu q 

Qgl ejc� s qcp K s jrg� S qcp 

Qgl ejc� r_qi gl e K s jrg� r_qi gl e 

Lmr� rgk c� Qf _pgl e Rgk c� qf _pgl e 
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l Open Source : Linux source code is freely available and it is 
community based development project. Multiple teams work in 
collaboration to enhance the capability of Linux operating system 
and it is continuously evolving.

l Multi-User : Linux is a multiuser system means multiple users can 
access system resources like memory/ ram/ application programs 
at same time.

l Multiprogramming : Linux is a multiprogramming system means 
multiple applications can run at same time.

l Hierarchical File System ? Linux provides a standard file structure 
in which system files/ user files are arranged. Files and directories 
are arranged in tree structure form

l Shell : Linux provides a special interpreter program which can be 
used to execute commands of the operating system. It can be used 
to do various types of operations, call application programs. etc.

l Security : Linux provides user security using authentication 
features like password protection/ controlled access to specific 
files/ encryption of data.
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6.5   Computer Security
 Computer security is the process of preventing and detecting unauthorized 
use of our computer. Prevention measures help us to stop unauthorized users 
(hackers) from accessing any part of our computer system. Detection helps us to 
determine whether or not someone attempted to break into our system, if they 
were successful, and what they may have done.
 Our computers have become an extension of everything we do from 
banking and investing to shopping and communicating with others through 
email or chat. We may not consider our communications "top secret," most likely 
we do not want strangers reading our email, using our computer to attack other 
systems, sending forged email from our computer, or examining personal 
information stored on our computer.
 Hackers do not care about our identity. Often they want to gain control of 
our computer so they can use it to launch attacks on other computer systems.
Having control of our computer gives the hackers the ability to hide their actual 
location as they launch attacks, often against high-profile computer systems 
such as government or financial systems.
 Hackers have the ability to watch all our actions on the computer, or cause 
damage to our computer by reformatting our hard drive or changing our data.
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 Internet Security is the most important aspect that everyone using the 
internet should understand. Here we are describing a few important tips to keep 
ourself secure and protect our Information from Security threats.

6.5.1  Latest Anti-virus software:
 New viruses and threats are being discovered everyday and to cope with 
that we need to have a latest version of the Anti-virus software. Even to make our 
Version of Anti- Virus software effective, we need to update it with latest updates 
available. There are many Anti- Virus Software available, both free and paid.
6.5.2  Anti-Spyware Software:
 Anti-virus software alone is not enough. To be secure from Internet 
Security threats we also need Anti-spyware software. Spyware programs are 
different from viruses in a way that unlike virus it does not alter the way in which 
our machines works or corrupt any data but it installs itself on our machine to 
send important data like passwords,  Credit card numbers stored on your 
machine to its server. So in order to detect spyware programs & prevent one from 
getting into our machine we need latest Anti-spyware software.
6.5.3  Password protection :
 Passwords are the most important aspect of various online accounts. They 
provide access to online accounts and enable us to perform various activities 
linked with account like shopping, emailing, online transactions etc. Keeping our 
password secure is like keeping money secure. Never keep same passwords for 
different accounts. Never keep password's that can be guessed or password 
relating to our personal's like telephone number, date of birth etc. Use long 
Password's consisting of both letters and digits and may be some special 
characters. Always Access Websites Related to our password directly by opening a 
new webpage and never through a link in email or provided otherwise.
6.5.4  Apply Latest Updates & Patches:
 No software installed on our system is perfect for life. Apply the latest 
updates & patches to the software. These updates and patches are made available 
from time to time by the software manufacturer.
6.5.5  Firewall:
 If possible try to Use a firewall to prevent hackers from attacking our 
system. Firewall blocks traffic not authorized to access our PC. Firewall enables 
us to access internet securely and prevent unauthorized applications and people 
from accessing our PC.



Points to Remember

1. An operating system is a program that acts as an interface between the user and the 

computer hardware.

2. Operating systems handle many kinds of activities from user programs to system 

programs like printer spooler, name servers, file server, etc. Each of these activities 

is encapsulated as a process.

3. A file represents a collection of related information. Computers can store files on the 

disk (secondary storage), for long-term storage purpose.

4. Time-sharing is a technique which enables many people, located at various 

terminals, to use a particular computer system at the same time.

5. Real-time systems are used when there are rigid time requirements on the operation 

of a processor.

6. Linux is one of popular version of UNIX operating System. It is open source as its 

source code is freely available.

7. Computer security is the process of preventing and detecting unauthorized use of 

our computer.
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1. Multiple Choice Questions:
1) An operating system is a
 a. Terminal
 b. Software
 c. Storage system
 d. Processor
2) The process of running multiple 

applications at the same time is known 
as

 a. Multi application
 b. Multi processing
 c. Multi programming
 d. Multi timing
3) It enables us to access internet securely 

and prevent unauthorized applications 
and people from accessing our PC.

 a. Anti-Virus
 b. Security
 c. Firewall
 d. None of these

Exercise Exercise 4) The time taken by the system to respond 
to an input and display of required 
updated information is

 a. Response time
 b. Access time
 c. Output time
 d. Total time 
5)  Remote access to servers is possible 
   from different locations in .
  a. Batch Processing System
  b. Time Sharing System
  c. Network Operating System
  d. Distributed system
2. Fill in the Blanks. 
 1) A ______ represents a collection of 

   related ___________. 
2) ________System use multiple 

__________ processors to serve 
multiple real-time applications and 
multiple users.

3) _______ is the process of preventing 
and detecting ___________ use of 
our computer.

4) ______provide access to _________ 
accounts and enable us to perform 
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various activities linked with account 
like shopping, emailing, online 
transactions etc. 

5) ______________ are used when there 
are _________ time requirements on 
the operation of a processor or the 
flow of data. 

3. True/False
1) The time taken by the system to 

respond to an input and display of 
required updated information is 
termed as the response time.

2) Anti-virus software alone is enough 
to be secure from Internet Security 
threats.

3) An Operating System cannot 
manage the communication between 
user and device drivers.

4) Linux source code is freely available 
and it is community based 
development project.

5) The OS manages all kinds of 
resources using schedulers.

4. Very short Answers type questions:

1) An interface between computer user 
and computer hardware is call 
as......

2) What hides the peculiarities of 
specific hardware devices from the 
users.

3) A mechanism or a way to control 
the access of programs, processes, 
or users to the resources defined by 
a computer system is called 
as......4) The process of 
preventing and detecting 
unauthorized use of our computer 
is called as......

5. Short answer type Questions:
1) What is an operating System?
2) List type of operating systems.
3) Explain real time operating system.
4) What are the functions of operating 

system? Make a list.
5) What do you mean by computer 

security?
6. Long Answer Type Questions:

1) Explain functions of operating 
system.

2) What are the basic features of Linux?

ĒÕØÞ ŃŐØ Key 

Î ŒŃØǾŊÖÕØ Ħ ŒÓǾŊŌÓŃ� ĖŅÖŊMŃ GŊÓÓ� ŊÕ� ǾŅŃ� ĔÓŁÕÒØ 
Ī ŐŒŃ� ÖŐ�
False 

İ ŃŐR� Ï ŅÖŐǾ� Ē ÕØÞ ŃŐ 

C 
Qmdru _pc Dgjc*� Gl dmpk _rgml  Rps c Mncp_rgl e� Qwqrck  

Ć 
� Multi 
programming 

Bgqrpg̀ srcb*� Acl rp_j D_jqc Bpgt cpq 

Ĉ 
Dgpcu _jj Amk nsrcp�

Security,Unauthorized 
D_jqc Npmrcargml  

Č Pcqnml qc� Rgk c N_qqu mpbq*� Ml jgl c Rps c Amk nsrcp� Qcaspgrw 

Ċ 
L etwork 
Operating System 

Pc_j� Rgk c� Qwqrck q*�
Rigid 

Rps c �

�



 7.1 What is Publisher?

 7.2 Microsoft Publisher 2010

 7.3 How to start publisher? 

 7.4 Creating a Publication

 7.5 Frames 
  

 7.6 Viewing Pages Templates
 
 7.7 Templates 

  
 7.8 Saving Your Publication 

 7.9 Printing Your Publication 

7.1 What is Publisher?
Publisher is an application used to design and produce attractive 

advertising and promotional material like pamphlets, letter heads, banners, 
posters, calendars, invitations, and newsletters and so on. This advertising 
and promotional material is called a publication.

Publisher enables us to produce quick publications by using wizards and 
a design gallery. A template is the predefined model of publication. We can view 
the publication on the monitor exactly the way it would appear when printed. 
Publisher also helps us keep track of the colors used in publications to produce 
high-quality color output. With the help of publisher, we can create quick web 
sites at a minimum cost with ease.

7.2 Microsoft Publisher 2010:
Publisher 2010 is a program that helps us design professional 

publications such as newsletters, websites, brochures, catalogs, flyers, signs, 
postcards, invitations, greeting and business cards, letterheads, envelopes, 
business forms, banners, calendars, certificates, and more.  Microsoft 
Publisher 2010 helps us create professional-looking publications quickly and 
easily. With Publisher, we can create, design, and publish professional 

Objectives of this chapter:

Chapter 
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marketing and communication materials for print, and for e mail. Publisher 
2010 allows us to apply built-in templates, to apply our own custom templates, 
and to search from a variety of templates available on Office.com. Office.com 
provides a wide selection of popular Publisher templates, including 
newsletters and flyers.

7.3 How to start publisher?
Follow the given steps to start Publisher:

On the Start menu, point to All Programs, point to Microsoft office, and then 
click Microsoft office publisher 2010.

1. Click on the start button.
2. The search bar is shown in start menu for searching the programs and 
 files.
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3. Type "Publisher" or "Pub" in search bar and press enter button.

 

Fig 7.3 Search Bar

Fig 7.1

Fig 7.2
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Fig 7.4 Publisher opening window

7.4 Creating a Publication 
 We can create new Publication by following methods:
 1. By using Blank Layout.
 2. By using Installed templates.
 3. By using online templates.

7.4.1 Creating a publication using blank Layout: 
 Following are the steps to start with a blank publication.
 1. Click the File Menu, and then click New.
 2. Under Available Templates, click a blank publication template,    
  and then click Create.

We can choose the desired size of blank template by clicking More 
Blank Page Sizes from the New Publication screen or even we can also 
customize the size as per our requirement. Here we have selected Blank 
8.5 x 11 (either Landscape or Portrait). 

Note:

Fig 7.5
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3. Now, we can create a publication with our own specifications in 
Publication.  We can also add the objects to the blank Layout like text, picture, 
word art, and auto shapes etc. The blank layout window is shown as below:

Fig 7.6 Blank Publication window 

4. After creating publication, save the publication by clicking on save 
option in File Menu. The Save As dialog box appears.  type a name for our 
publication, select the folder in which we want to save it, and then click save 
button. The publication is saved with a .pub extension.
5. Close the publication by clicking close button in File menu. A dialog 
box appears, if we want to save the changes, then click yes button, otherwise 
click no.
Before exiting Publisher, we should close all the publications, then Click Exit 
in File Menu or click cross button on title bar.

7.4.2 Components of publisher window
There are three most important components that we should remember as we 
work within Publisher 2010. These are:
 7.4.2.1 The Quick Access Toolbar
 7.4.2.2 The Ribbon
 7.4.2.3 The File Window.

7.4.2.1 Quick Access Toolbar 
 The quick access toolbar is a customizable toolbar that contains 
commands that we may want to use. We can place the quick access toolbar 
above or below the ribbon. To change the location of the quick access toolbar, 



click on the arrow at the end of the toolbar and click Show below the Ribbon. We 
can also add items to the quick access toolbar, simply click on any item and it 
will be added to our toolbar. 

 

7.4.2.2 Ribbon 
 The ribbon is the panel at the top portion of the document it has six tabs: 
Home, Insert, Page Design, Mailings, Review, and View. Each tab is divided into 
groups

Fig 7.8 Ribbon of Publisher 
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Fig. 7.7 Customize Quick Access Toolbar

7.4.2.3  File Window 
 When we click on the File Menu, we are brought to the Info screen. It 
looks like that our document is gone, but it is not. As we click on the options 
in the File Menu, the screen will change accordingly. 
l Save: Save the file as a 2010 file 
l Save As: Allows you to choose a different file type (i.e. PDF, Word) 
l Open: used to open a publisher file 
l Close: Closes the file but keeps Publisher running 
l Info: Edit Business Information, use Design Checker, and set Commercial  
 Print Information 



Fig 7.9 File Window
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l Recent: List of our recently used Publisher files 
l New: New Publication Screen 
l Print: Print Options 
l Save & Send: Options for saving and e-mailing the file 
l Help: Microsoft Help 
l Options: Set default options 
l Exit: Closes Publisher (file and program)

7.4.3 Working in publication:
7.4.3.1 Adding Text:
 1. From the Home or Insert Tab, select Draw Text Box. 
 2. Place the cursor on the page where we want to draw a text box. 
 3. Click and drag the cursor across the page to the desired size. The 
  size of the text box can be changed after we have drawn it. 
 4. When we let go of the left click on the mouse, we are brought to   
  the format tab which gives us more options for the text box.
 5. Type the text in text box. 

Fig. 7.10



7.4.3.2 Editing Text:
 1. Highlight the text we want to edit. 
2. If we are not brought to the Text Box Tools Format Tab, then 

select it. 
3. Text Group Options: 
  a. Text Fit - Defines how the text will fit in the text box: Best 

Fit, Shrink Text on Overflow, Grow Text Box to Fit, Do Not 
Auto-Fit 

  b. Text Direction - Changes direction to horizontal or vertical 
  c. Hyphenation - Changes hyphenation behavior of selected 

text.
4. Font Group Options: Style, Font Size, Bold, Italics, Underline, 

Text Spacing, & Color
5. Alignment Group Options: Text Box Alignment, Columns, 

Margins 
6. Effects Group Options: Shadow, Outline, Engrave, Emboss 

7.4.3.1  Changing the Text Box Style: To change the text box style follow the 
steps:

1. Click on the text box.

 2. Click on the Drawing Tools Format Tab.

 3. Shape Styles Group Options: Style, Shape Fill, Shape Outline, 
Change Shape

 4. Arrange Group Options: Wrap Text, Bring Forward or Backward, 
Rotate

7.4.3.4 Inserting Clip Art:  To insert the clip Art follow the steps:
1. Click on the Insert Tab. 
2. Click Clip Art. The Clip Art window appears on the right side of 

the screen. 
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Fig. 7.11

Fig. 7.12



3. Type in a keyword.
4. Click Go.
5. Browse through the results. 
6. When we find clip Art, click on the thumbnail from the Clip Art 

Window. 
7. The Clip Art image will then appear on our page.

7.4.3.5 Inserting a Picture: To insert a picture follow the steps:

1. Click on the Home or Insert tab.

2.  Click on Picture.

3. Browse to the location of the picture we have saved on our 
computer.

4. Select the picture and click Insert.
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Fig. 7.13

Fig. 7.14

7.4.3.6 Inserting Shapes: To insert a shape follow the steps:
 1. Click on the Home or Insert tab.
 2. Click on Shapes.
 3. Select a shape from the drop down menu. 
 4. On the page, click and drag to create the shape.
 5. The shape appears on the page, and we are brought to the Drawing   
  Tools  
 6. Format tab. From this tab, we can edit the style, fill, outline, and more. 



7.4.3.7 Text Wrapping: Text wrapping is the way our object is set on the 
page in reference to the text. To do text wrapping following are the steps:
 1. Select the Object. 
 2. Click on the Format tab (Text Box, Drawing, or Picture Format). 
 3. In the Arrange group, click on Wrap Text. This will determine how 

text will be arranged around the object. 
 
 Here are the Options:  None, Top & Bottom, Square, Through, Tight, 
More Layout Options 

�
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Fig. 7.16



7.4.3.8 Resizing Objects: Resizing enables us to resize our objects.
 1. Click on the object. 
2. Click and drag the handles to resize. 
  a. The corner handles will resize the object proportionally. 
  b. The handles centered on the lines of the box will stretch the 

object vertically and horizontally. 
The green handle allows us to rotate the object.

7.4.3.9 Moving Objects: 

 1. Click on the object.

 2. Place our cursor over the solid line so that we see the 
crosshairs.

 3. Click and drag the object to the desired location.

�

�

7.4.3.10 Deleting Objects: We can also delete any object, if do not 
require it in our publication.
 1. Click on the object.
 2. Press Delete button on the keyboard.

7.5 Frame -
 Most publications are divided into several different areas called frames. 
A frame can contain a variety of objects such as graphics, tables, or text 
boxes. Frames can be resized, moved and manipulated to suit your needs. 

7.5.1 Working with Frames 
 Each publication is composed of different frames, such as text frames, 
picture frames, table frames, and shape/object frames. Click on different 
areas of the publication to identify the different frames. Handles, little circles 
on the corners and sides of the frame will appear. The handles help us to show 
which frame we have selected. These are also used in resizing frames.
  Handles - When we click on a frame, small circles appear around the 
edge of the frame. These are called handles. We can click and drag on the 
handles to resize our frame. 
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7.5.2  Moving Frames: 
7.5.2.1 To move a picture frame, 
 1. Click on the picture. 
 2. When our cursor turns into a four directional arrow, click and 
  drag the picture frame to the desired location.
7.5.2.2 To move a text frame:
 1. Click on the text frame. 
 2. Rest our cursor near the border of the text frame. When our 
  cursor turns into a four directional arrow, click and drag the   
  text frame to the desired location. 

7.5.3 Resizing Frames:

7.5.3.1  To resize a picture frame:
 1. Click on the picture. 
 2. Rest our cursor on a corner handle. When our cursor turns 

into a diagonal line with arrows on the ends, click and drag 
inwards at a diagonal to make it smaller or outwards at a 
diagonal to make it larger. Using corner handles to resize 
pictures allows us to keep the picture's proportions. 

7.5.3.1 To resize a text frame:
 1. Click on the text frame. 
 2. Rest your cursor on one of the handles. When your cursor turns 
  into a line with arrows on the ends, click and drag inwards or 
   outwards to resize the text area.

7.5.4  Deleting Frames: 
1. Right click on the frame that we would like to delete. 
2. Select Delete Object from the list of choices. 

7.5.5  Inserting Additional Text Frames :
1. Click on Text box from the Insert Tab 
2. Click and drag over an area of the publication. 
3. Type the text we want to appear. 
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7.6 Viewing Pages in our Publication : There are three ways to view pages in 
a publication: 
l Click on the thumbnails of the pages in the publication from the Page 

Navigation Window on the left hand side of the screen. 

Fig 7.21 Page navigation view

l From the View tab, we can switch from single page to two-page 
spread view as well as choose other viewing options. 

l On the bottom right corner of Publisher, we can change our view as 
well as zoom in and out using the slider. 

Fig 7.23 Zoom in Zoom out slider

7.7 Template ? A Template is a tool used in Publisher to help us easily create 
basic publications. The template has a set of pre designed styles that we can use 
as it is or customize as we see fit. 
7.7.1 Customizing the Template: Here we will learn how to customize a 
Template. Choose the publication type that we would like to use. The next 
screen will show us templates for the publication we have chosen. 
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Fig 7.24 Templates

Each template is customizable. Click on a template from the center. On the 
right side of the screen, we can change the template colors, fonts, and more. 
Once we have found a template and customized it, click Create. After we click 
create, we can edit the text boxes, images, and shapes that have been set up by 
the template as needed.

7.7.1.1 Changing the Design of a Template: To change the design 
template follow steps:

  1. Click on the Page Design tab.
  2. To change the entire template, click Change Template.
   l Choose a template from the pop up window. If we  

  are currently working in a template and changing  
  to a different template, the information we have  
   entered will conform to the new template.

  3. To change the color scheme, browse through the color  
   schemes available in the Schemes group.

l However the mouse over the color scheme to   
  preview.

l To select a color scheme, click on it.
  4. To change the font scheme, click on Fonts in the 
   Schemes group.

l Browse through the available font schemes.
l However the mouse over the font scheme to   

  preview.
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l To select a font scheme, click on it.
l If we want to create our own font scheme, click  

 
 Create New Print Scheme.

7.7.1 Page Design:
 l Click the tab Page Design if needed, to change templates, adjust page 

margins, apply ruler guides, or apply built-in color schemes to the 
chosen template.

l We can use the Built-in Ruler Guide templates to help in aligning text 
boxes, pictures, or other objects. To apply a Built-in Ruler Guide 
template click on the command Guides in the group Layout, and then 
choose a template.

l To add a vertical or horizontal ruler guide repeat the above step, then 
click on Add Vertical or Horizontal Ruler Guide.

l To add additional guides, move the mouse pointer over the vertical or 
horizontal ruler; drag the guide in the desired direction when the 
pointer changes to a two headed arrow.

7.7.2 Creating a Publication with Templates:
 We can create a publication in Publisher by using template. 
Available Publication Types:  Publisher 2010 allows us:

l To apply built-in templates, 
l   To apply our own custom templates, and 
l To search from a variety of templates available on Office.com. 

Office.com provides a wide selection of popular Publisher templates, 
  including newsletters and flyers. To find and apply a template in  
  Publisher 2010, do the following:

1. On the File tab, click New.
2. Under Available Templates, do one of the following:

l To use a template that we already have installed, click My Templates, 
click the template that we want, and then click Create.

l To use one of the pre-built templates installed in Publisher, under  
   Most Popular or More Templates, click the category that we want,  
   click the template that we want, and then click Create.

l To find and apply a template on Office.com, under Most Popular or 
 More  Templates, click the category that we want, click the template 

 
 that we want, and then click Download.
Note:

We can also search for templates on Office.com from within Publisher. In the Search 
for templates box, type one or more search terms, and then click the arrow button to 
search
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7.5.2.1 Creating publication with Installed templates:
  We can create any publication easily with the help of the 

installed templates available in Publisher. We can use pre 
designed templates in publisher and create so many 
publications like Brochures, Business Cards, Calendars, 
Greeting Cards, Labels, Newsletters, Postcards, 
Advertisements, Award Certificates, Banners, Business 
Forms, Catalogs, E-mail, Envelops, Flyers, Gift certificates, 
Invitation cards, Letterhead, menus, resumes and so many 
quick publications. 

7.7.2.2 Creating publication with online templates:
 We can create any publication easily with the help of the internet, 

because we have also a option to create publication using online 
templates. For online templates, internet facility is available in 
our system.

To find and apply a template on online Templates, click the 
category that we want, click the template that we want, and then 
click Download, and then apply that template.
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7.8 Saving Your Publication: There are two basic ways to save our 
 publication. 
 First one is to Point and click on the save icon on our toolbar. 
     OR 
 Follow these steps: 
 1. Click on the File Menu and Save As. 
 2. When the Save As Dialogue Box appears Click Browse and    find     
  the location on computer where you want to save the file        
  saved. 
 3. Type the name of our publication in the File Name field. 
 4. Click on the Save button. 

7.9 Printing Your Publication: There are two basic ways to print your 
 publication. 

First one is to click on the print icon on toolbar. This will print 
one copy of our publication with the default print options. 

OR 
 1. Click on the File Menu and click Print.
 2. When the print window appears, select the desired    

 number of  copies.
 3. Choose any other Print Settings:   

l All Pages, Selection, Current Page, or Custom Range 
   l Manually enter page numbers we want to print 

l How many pages print per sheet of paper 
l Paper Size 
l 1-sided or 2-sided printing 

 4. Click Print. 

Points to Remember

1. Publisher is an application used to design and produce attractive 
advertising and promotional material

2. A template is the predefined model of publication

3. Publisher enables us to produce quick publications by using 
wizards and a design gallery

4. To open the Microsoft publisher by keyboard, Type “Publisher” in 
search bar and press enter button
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5. We can also add the objects to the blank Layout like text, picture, 
word art, and auto shapes etc.

6. After creating publication, save the publication by clicking on save 
option in File Tab

7.  Close the publication by clicking close button in File menu

8. Before exiting Publisher, we should close all the publications

9. We can place the quick access toolbar above or below the ribbon

10. We can also add items to the quick access toolbar, simply click on any 
item 

11. The ribbon is the panel at the top portion of the document it has six 
tabs

12. Each tab is divided into groups

13. To view additional features within each group, click the dialog box 
launcher (arrow) at the bottom right corner of each group.

14. Click and drag the handles to resize

15. The corner handles will resize the object proportionally

16. The handles centered on the lines of the box will stretch the object 
vertically and horizontally

17. The green handle allows you to rotate the object

18. Place our cursor over the solid line so that we see the crosshairs.

19. Click and drag the object to the desired location

20. Most publications are divided into several different areas called 
frames

21. When we click on a frame, small circles appear around the edge of the 
frame. These are called handles

22. We can click and drag on the handles to resize our frame. 

23. A Template is a tool used in Publisher to help us easily create basic 
publications

24. In arrange group, the text will be arranged around the object by using 
Wrap Text

25. If we want to delete any objects which are not required in publication, 
click on the object and press Delete button from the keyboard.
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1. Multiple Choice Questions:

1. Choose an application used to design 
and produce attractive advertising and 
promotional material. 

 a) Document b) Spreadsheet 
 c) Publication d) Presentation

2. Publisher enables us to produce quick 
publications by using ________.

 a) Manual b) Wizards   
 c) Customize d) All of these

3. To open the Microsoft publisher by 
keyboard, what we need to type in 
search bar?

 a) WordPad b) Notepad  
 c) Access  d) Publisher

4. Each tab is divided into __________.

 a) Groups  b) Blocks  
 c) Menus  d) Parts

5. After creating publication, save the 
publication by clicking on save option                     
in ___________.

 a) File   b) Home   
 c) Insert   d) View 

6.  Close the publication by clicking   

  _______ button in File menu.

 a) Open  b) New  
 c) Print  d) Close

2. Fill in the Blanks:

1. We can also add the objects to the 
blank Layout like ________, _________, 
word art, and auto shapes etc.

2. The handles centered on the lines of 
the box will stretch the object 
__________ and _________

Exercise Exercise 
3. We can ________ and _________on the 

handles to resize our frame.
4. To view additional features within 

each group, click the dialog box 
launcher (arrow) at the bottom 
___________of each__________.

5. When we click on a_________, small 
circles appear around the edge of the 
frame. These are called___________.

3. True or False:
1. A Template is a tool used in 

Publisher to help us easily create 
basic publication.

2. Most publications are divided into 
several different areas called 
frames.

3. The corner handles will resize the 
object proportionally.

4. Before exiting Publisher, we should 
not close all the publications.

5. We cannot add items to the quick 
access toolbar by click on any item.

4. Very Short Answer type Questions: 

1. Extension used to save a publication 
is?

2. To move objects which cursor is 
used?

3. Online Templates are available in?
4. List of our recently used Publisher 

files are in?
5. The text is arranged around the 

object by using which option?

5. Short Answer type Questions:

1. What is Publisher?
2. Write the steps for Moving 

Objects in publisher.
3. Define Templates?
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6. Long Answer type Questions:

 1. How to create a publication 
using blank Layout in 
publisher?

2. How to add text using text box 
and write the steps for editing 
text in publisher?

3. How to Print your Publication? 
Write their steps.
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Ĉ Publication Text and Picture True .pub 

Č Wizards 
Vertically and 

horizontally 
True crosshairs 

Ċ Publisher Click and drag True Office.com 

Ç  Groups Right corner, group False Recent 

D  File Frame, handles False Wrap Text 

Ď Close - - - 
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 8.1 Advertisements

 8.2 Business Cards

 8.3 Greeting Cards / Invitation Cards / Compliment Cards

 8.4 Award Certificates

 8.5 Envelops

 8.6 Labels

 8.7 Letterhead

 8.8 Calendars

 8.9 Resumes

 8.10  Menus

 8.11  Signs 

 8.12  Paper folding projects 
  

8.1 Advertisements: 
 Advertising means how a company encourages people to buy their 
products, services or ideas. An advertisement or "ad" for short is anything that 
draws good attention towards these things. It is usually designed by an 
advertising agency. Ads appear on television, as well as radio, newspapers, 
magazines etc. Advertising is an audio or visual form of marketing 
communication that employs an openly sponsored, non-personal message to 
promote or sell a product, service or idea. Sponsors of advertising are often 
businesses who wish to promote their products or services. 
 Advertising is communicated through various mass media, including old 
media such as newspapers, magazines, Television, Radio, outdoor advertising 
or direct mail; or new media such as search results, blogs, websites or text 
messages. The actual presentation of the message in a media is referred to as 
an advertisement or "ad". Non-commercial advertisers include political 
parties, interest groups, religious organizations and governmental agencies. 
The following figure shows an example of an advertisement.

Objectives of this chapter:

Chapter 
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MS – Publisher offers templates and other tools to help us create a variety of 
publications, including brochures, newsletters, business cards, and menus. 
Various print media used for advertisement are:

8.1.1 Brochures

8.1.2 News letters

8.1.3 Banners

8.1.4 Catalogs

8.1.5 Flyers

8.1.1 Brochure:

 A brochure is an informative paper document often used for advertising 
that can be folded into a template, pamphlet or leaflet. Brochures are 
promotional documents, primarily used to introduce a company, organization, 
products or services to the public. Brochures are distributed inside 
newspapers, handed out personally or placed in brochure racks in high traffic 
locations. They may be considered as grey literature.
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Now day's brochures are also available in electronic format and are called e-
brochures. They have the added benefit of having unlimited distribution and 
cost savings when compared to traditional 
paper brochures.

 The most common types of single-sheet 
brochures are the bi-fold (a single sheet 
printed on both sides and folded into halves) 
and the tri-fold (the same, but folded into 
thirds). A bi-fold brochure results in four 
panels (two panels on each side), while a tri-
fold results in six panels (three panels on 
each side).
 Other brochure fold arrangements are 
also possible: the accordion or "z-fold" 
method, the "c-fold" method, etc. Larger 
sheets, such as those with detailed maps or 
expansive photo spreads, are folded into 
four, five, or six panels. 
 Booklet brochures are made of multiple sheets most often saddle 
stitched stapled on the creased edge, or perfect bound like a paperback book, 
and result in eight or more panels.
8.1.1.1  Creating Brochures using MS-Publisher:
 Steps to create Brochures in Publisher:
1. Click on File Tab, then New, and then Brochures.
There are many Templates related with brochures, which are already available 
in Install Templates. Select any one according to our choice. Now, we can see at 
right side of window, many options are available for customizing this selected 
brochure.

Fig 8.2

Fig 8.3
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2. Now, customize our brochure with the help of color scheme, font scheme, page  
 size options and forms.

Color Scheme              Font Scheme              Page Size               
Form

3. After changing of color, fonts, size and forms of brochure, click 
on Create option.

4. We will see the brochure as shown in figure below.

Fig 8.4

Fig 8.5

Fig 8.6



Now we can edit our brochure's details and save it as publication.
8.1.2 Newsletters:
 A newsletter is a printed report containing news or information of the 
activities of a business or an organization that is sent by mail regularly to all its 
members, customers, employees or people, who are interested in. Newsletters 
generally contain one main topic of interest to its recipients. A newsletter may 
be considered grey literature.
 E-newsletters delivered electronically via e-mail and can be viewed as 
spamming if sent unsolicited. 
8.1.2.1 Creating Newsletters using MS-Publisher:
 Steps to create Newsletters in Publisher:
 1. Click on File Tab, then New, and then Newsletters.

2. Select newsletter design from available Templates as per requirement 
 and click on Create.
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Fig 8.7

Fig 8.8



Now we can edit our newsletter's details and save it as a publication.
8.1.3 Banners:
 A long strip of cloth bearing a slogan or design carried in a 
demonstration, procession or hung in a public place. Depending on how it is 
used, a banner can be a flag or other piece of cloth bearing a symbol, logo, 
slogan or other marketing message. 
 An online banner is either a graphic image that announces the name or 
identity of a site. An online banner is a typically rectangular advertisement 
placed on a Web site's main content and is linked to the advertiser's own Web 
site.
8.1.3.1  Creating Banners using MS-Publisher:
 Steps to create Newsletters in Publisher:
 1. Click on File Tab, then New, and then Banners.

2. Select newsletter design from Available Templates as per requirement, 
here we have three categories: Congratulations, Event and Get well. 
3. Click on Create button.
Banner will be shown as in figure below:

Now we can edit the banner and save it.
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Fig 8.9

Fig 8.10



8.1.4 Flyers:
 A flyer is a form of paper advertisement used for wide distribution, 
posted or distributed in a public place, handed out to individuals or sent 
through the mail. Flyers range from inexpensive photocopied leaflets to 
expensive, glossy, full-color circulars. Flyers may be used by anyone including 
individuals, businesses, not-for-profit organizations or governments for:

  a) Advertising an event such as a live concert, nightclub 
appearance, festival, or a rally

b) Promotion of a business, discount store or a service business 
such as a restaurant or a gym.

c) Persuading people about a social, religious, or political 
message, campaign activities on behalf of a political party or 
candidate during an election. 

d) Recruiting members for organizations or companies.
 
 In Installed Templates, various flyers for different events and 
marketing are available in MS publisher. We can choose the flyers as per our 
requirement. After that we can edit the basic information to be displayed on 
it and save it as a publication. Example of a flyer is shown in the figure 
below:
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Fig 8.11



8.2 Business Cards: A small card printed with one's name, occupation, 
business address, etc. is called a business card.
 Business cards are cards bearing business information about a company 
or individual. They are shared during formal introductions. A business card 
typically includes the giver's name, company or business affiliation (usually 
with a logo) and contact information such as street addresses, telephone 
number (s), fax number, e-mail addresses and website. In these days, business 
cards may also include social media addresses such as Facebook and Twitter. 
Traditionally many cards were simple black text on white stock; today a 
professional business card will sometimes include one or more visual design.
8.2.1 Creating Business Card in Publisher:
 1. Click on File Tab, then New, and then Business Card.

 There are so many Templates are available in Install Templates 
related with Business Card. Select any one according to our choice. 
On right side of window, we can customize this selected Business 
Card with the help of color scheme, font scheme, business 
information, page size options and logo.

2. After changing of color, fonts scheme, business information and 
page size, click on Create button.
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3. Now, we will see the Business Card as shown as below figure. The 
Business Card is designed successfully. Now we can change Business Name or 
Individual name also, Address, Contacts etc. 

Fig 8.12
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Fig 8.13
8.3 Greeting Card/ Invitation card/ compliment card: 
 A greeting card/ Invitation card/ compliment card is a piece of card or 
high quality paper expressing friendship or any other sentiment. Although 
these cards are usually given on special occasions such as Birthdays, 
Anniversary, Christmas, Diwali or other holidays, they are also sent to convey 
thanks or express other feelings. These cards are usually packaged with an 
envelope, come in a variety of styles. There are both mass-produced as well as 
handmade versions that are distributed by hundreds of companies. 

Fig 8.14 Fig 8.15Greeting Card                                      Invitation Cards 

Fig 8.16 Compliment Cards

These can also be designed with the help of MS Publisher.



8.2 Award Certificates: 
An award is something given to a person, a group of people, or an 

organization in  of their  in a certain field. An award may recognition excellence
be accompanied by , , certificate, , , , or . trophy title medal badge pin ribbon

Certification refers to the confirmation of certain characteristics of an 
object, person, or organization. This confirmation is often, but not always, 
provided by some form of external review, education, assessment, or . audit  

Certificates of achievement, merit, and honor can be powerful tools when 
used at the right time and presented in the right way. Receiving an award 
certificate gives a person the warm glow of knowing someone took the time to 
acknowledge them. And being the person who motivates others can be 
rewarding, too.

Award certificates may include: Community Service Award, Great Job, 
Good Behavior or Course Completion. MS Publisher provides many templates 
for creating Award Certificates. Figure shown below is an example of certificate 
of Appreciation created using MS publisher.

Various Templates in MS publisher as shown in figure below can be 
used to create this certificate.  
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Fig 8.17



After selecting the required certificate design, edit the color scheme and click 
on Create button. Now we can edit the certificate information and save it as a 
publication.

8.5 Envelops: 
 An envelope is a common packaging item, usually made of thin flat 
material. It is a flat paper container with a sealable flap designed to enclose a 
flat object, such as a letter, card or document. Traditional envelopes are made 
from sheets of paper. They are most commonly used for enclosing and sending 
mail (letters) through a prepaid-postage postal system.
 Envelop with mailer's address and recipient's address may look like the 
figure shown below.
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Fig 8.18

Fig 8.19



We can create envelop with Various Templates in MS publisher. After selecting 
the required envelop design, edit the color scheme and click on Create button. 
Now we can edit the envelop information and save it as a publication.
8.6 Labels:  
 A label is a piece of paper, polymer, cloth, metal, or other material affixed 
to a container or product. Information printed directly on a container or item 
can also be considered labeling. Labels have many uses, including providing 
information on a product's origin, manufacturer (e.g., brand name), use, shelf-
life and disposal etc. Many hazardous products such as poisons or flammable 
liquids must have a warning label.
Labels can be used for:

l Products: Permanent product labels need to remain secure 
throughout the life of the product. For example, a food label must 
be secure until the food has been used. 

l Packaging: Packaging may have labeling attached to or integral 
with the package. These may carry pricing, barcodes, UPC 
(Universal Product Code) identification, usage guidance, 
addresses, advertising, recipes, and so on.

l Assets:  In industrial or military environments, asset labeling is 
used to clearly identify assets for maintenance and operational 
purposes. Such labels are frequently made of engraved Trifoliate or 
a similar material.

l Textiles:  Garments normally carry separate care/treatment 
labels which typically indicate how the item should be washed for 
e.g. machine washed or dry cleaned. Textile labels may be woven 
into the garment or attached, and may be heat resistant, colorfast, 
washable. Printed labels are an alternative to woven labels.

l Mailing: Mailing labels identify the addressee, the sender and any 
other information which may be useful in transit.

l Security labels: They are used for authentication, theft reduction, 
and protection against counterfeit and are commonly used on ID 
cards, credit cards, packaging, and products from CDs to 
electronics to clothing.

 Labels may be used for any combination of identification, information, 
and warning, instructions for use, environmental advice or advertising. They 
may be stickers, permanent or temporary labels or printed packaging.
8.6.1 Creating Labels in Publisher: 
 Here we are designing a label for a CD/DVD with the help of MS 
publisher. Follow the steps written below:
 1. Click on File Tab, then New, and then Labels.
 2. In category Media, select All Media. Here select the CD/DVD    
  Labels. Select required template, edit the color scheme and click 
  on Create button. 
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3. Here we can edit the information related CD/DVD which is to be 
shown on the label

4. Save the label as a publication for future use. We can print these 
labels as per our requirement.
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Fig 8.20

Fig 8.21



8.7 Letterhead: 
 It is stationery with a printed heading. The heading usually consists of a 
name and an address, a logo or corporate design, and sometimes a background 
pattern. The term "letterhead" is often used to refer to the whole sheet imprinted 
with such a heading. Many companies and individuals prefer to create a 
letterhead template in a word processor or other software application. This 
generally includes the same information as pre-printed stationery, but at lower 
cost. Letterhead can then be printed on stationery or plain paper as needed or 
sent electronically.

8.7.1 Creating Letterhead in Publisher: 
 Here we are creating a Letterhead for an organization using MS publisher. 
Follow the steps written below:
1. Click on File Tab, then New, and then Letterhead.
There are many Templates are available in Install Templates related with 
Letterhead. Select any one according to our choice. On right side of window, we 
can customize color scheme, font scheme, business information and logo.

1. After changing of color, fonts, size and other information, click on 
Create option. The letterhead will be shown.

2. Now edit the necessary information as we can see in the figure 
below and save the changes.
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Fig 8.22



8.8 Calendar:
 A calendar is a system of organizing days for social, religious, commercial or 
administrative purposes. This is done by giving names to periods of time, typically 
days, weeks, months and years. Calendars are also used to help people manage 
their personal schedules, time and activities. 
 Calendars are also used as part of a complete timekeeping system: date 
and time of day together to specify a moment in time. 

8.8.1 Creating Calendars in MS Publisher:
 To create Calendar in Publisher, follow these steps:
 1. Click on File Tab, then New, and then Calendars.

From the Templates related to Calendars, available in install Templates, 
select any one according to our choice. Now, we can see at right side of window, 
there are many options available for customizing this selected Calendars.
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Fig 8.23

Fig 8.24



2. Now, customize our calendar with the help of color scheme, font scheme, 
Business information, page size options and specially Timeframe (One 
month per page or One year per page).

3. After customizing Calendars, click on Create option.
4. Now, we will see the Calendar as shown in figure below. If we want, we 

can edit the picture also and can save this calender in publisher.

8.9 Resumes:
 A resume provides a summary of our education, work history, 
credentials, and other accomplishments and skills. There are also optional 
sections, including a resume objective and career summary statement. 
Resumes are the most common document requested of applicants in job 
applications. A resume should be as concise as possible. Typically, a resume is 
one page long, although sometimes it can be as long as two pages. Often 
resumes include bulleted lists to keep information concise.

8.9.1 Creating Resumes in MS Publisher:
 To create Resumes in Publisher, follow these steps:
1. Click on File Tab, then New, and then Resumes.

From the Templates related to Resumes, available in install 
Templates, select any one according to our choice. After customizing 
the selected Resume click on Create button.
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Fig 8.25



2. Now edit the necessary information in our resume and save the 
changes. The resume will be as figure shown below.
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Fig 8.26

Fig 8.27



8.9.2 Curriculum vitae(CV): 
 Like resume, a curriculum vitaE (CV) provides a summary of one's 
experience and skills. Typically, CVs are longer than resumes - at least two or 
three pages. CVs include information on one's academic background, 
including teaching experience, degrees, research, awards, publications, 
presentations, and other achievements. CVs are thus much longer than 
resumes, and include more information, particularly related to academic 
background. 
 We can create CVs with the help of MS Publisher in same way we have 
created Resumes above.

8.10 Menus: 
 In a restaurant, there is a menu of food and beverage offerings. A menu 
may be a list from which guests use to choose options available. Basically Menu 
is the main way to give or take order from guest. Guest may order properly to 
see the menu and be aware about our food and price. MS Publisher provides 
many templates for creating a Menu. Below figure shows the example Menu 
designed in MS Publisher.
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Fig 8.28



8.12 Paper Folding Projects:
 The paper folding templates include patterns for paper airplanes and 
origami projects alike.  They include pages (that may require trimming) with "fold-
lines" and others with instructions to create our paper masterpieces.   We can 
enjoy these Paper Folding Projects in our leisure time and can make some creative 
things.
 Microsoft Publisher offers templates for kids. These templates consist of 
different paper folding projects like airplanes, boats, cups, and more.
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Fig 8.29

8.11 Signs:
 A sign is a piece of paper, clothe, wood or any other material which is 
painted with pictures or words and which gives some information about a 
particular place, product, or event. MS Publisher provides us with many of 
these signs as shown in figure below. We can create any of these sign using 
publisher.
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Points to Remember

1. Advertising means how a company encourages people to buy 
their products, services or ideas.

2. MS - Publisher offers templates and other tools to help us 
create a variety of publications, including brochures, 
newsletters, business cards, and menus.

3. Brochures are promotional documents, primarily used to 
introduce a company, organization, products or services to the 
public.

4. Now day's brochures are also available in electronic format 
and are called e-brochures

5. A newsletter is a printed report containing news or information 
of the activities of a business or an organization.

6. A long strip of cloth bearing a slogan or design carried in a 
demonstration, procession or hung in a public place.

7. A flyer is a form of paper advertisement used for wide 
distribution, posted or distributed in a public place, handed 
out to individuals or sent through the mail.

8. Business Cards: A small card printed with one's name, 
occupation, business address, etc. is called a business card.

9. Business cards are cards bearing business information about 
a company or individual

10. A greeting card/ Invitation card/ compliment card is a piece of 
card or high quality paper expressing friendship or any other 
sentiment.

11. An award is something given to a person, a group of people, or 
an organization in recognition of their excellence in a certain 
field. An award may be accompanied by trophy, title, 
certificate, medal, badge, pin, or ribbon.

12. Certificates of achievement, merit, and honor can be powerful 
tools when used at the right time and presented in the right 
way.

13. An envelope is a common packaging item, usually made of thin 
flat material. It is a flat paper container with a sealable flap 
designed to enclose a flat object, such as a letter, card or 
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document. Traditional envelopes are made from sheets of 
paper. They are most commonly used for enclosing and 
sending mail (letters) through a prepaid-postage postal system

14. A label is a piece of paper, polymer, cloth, metal, or other 
material affixed to a container or product.

15. It is stationery with a printed heading. The heading usually 
consists of a name and an address, a logo or corporate design, 
and sometimes a background pattern.

16. A calendar is a system of organizing days for social, religious, 
commercial or administrative purposes. This is done by giving 
names to periods of time, typically days, weeks, months and 
years.

17. A resume provides a summary of our education, work history, 
credentials, and other accomplishments and skills. There are 
also optional sections, including a resume objective and career 
summary statement.

18. Resumes are the most common document requested of 
applicants in job applications. A resume should be as concise 
as possible.

19. A curriculum vita (CV) provides a summary of one's experience 
and skills. Typically, CVs are longer than resumes - at least 
two or three pages. CVs include information on one's 
academic background, including teaching experience, degrees, 
research, awards, publications, presentations, and other 
achievements.

20. Menu is the main way to give or take order from guest. Guest 
may order properly to see the menu and be aware about our 
food and price.

21. A sign is a piece of paper, cloth, wood or any other material 
which is painted with pictures or words and which gives some 
information about a particular place, product, or event.

22. We can enjoy these Paper Folding Projects in our leisure time 
and can make some creative things.

23. Microsoft Publisher offers templates for kids. These templates 
consist of different paper folding projects like airplanes, boats, 
cups, and more.



1. Multiple Choice Questions:
1. Now day's brochures are also available 

in electronic format and are 
called..........

 a) e-brochures b) m-brochures  
c) t-brochures         d) k-brochures
2. A small card printed with one's   
name, occupation, business address,  
etc. is  called .................
 a) Brochures         b) Newsletters 
 c) Business cards  d) Menus   
3. What is the most common document  
r eques t ed  o f  app l i can ts  in  j ob    
applications?
 a) Banner  b) Resume 
 c) Calendar  d) Flyer
4. What are longer than resumes - at  
least two or three pages?
 a)Curriculum vita (CV)  
 b) Banner   
 c) Invitation   
 d) Catalogue
2. Fill in the Blanks:
1.  Advertising means how a company 

encourages people to buy their......... 
.or ideas.

2. MS - Publisher offers templates and 
other tools to help us create a variety 
of publications, including brochures, 
newsletters, ........, and .................

3. Business cards are cards bearing 
business information about a ............ 
or................

4. A resume provides a summary of our 
..............., ..............credentials, and 
other accomplishments and skills.

3. True or False:

1. A compliment card is a piece of card or 
high quality paper expressing 
friendship or any other sentiment.

2. Certificates of achievement, 
merit, and honor can be powerful 
tools. 

3. Brochures are promotional 
documents, primarily never used 
to  introduce a company,  
organization,  

4. Very Short Answer type 
Questions: 

1. What is a piece of paper, cloth, 
wood or any other material which 
is painted with pictures or words 
a n d w h i c h  g i v e s  s o m e   
information about a particular 
place, product, or event

2. What is a common packaging 
item, usually made of thin flat 
material?

3. What is something given to a 
person, a group of people, or an 
organization in recognition of 
their excellence in a certain field?

4. W h a t  i s  a  f o r m  o f  p a p e r  
advertisement used for wide 
distribution, posted or distributed in 
a public place, handed out to 
individuals or sent through the 
mail?

5. What is a printed report 
containing news or information 
of the activities of a business or 
an organization

5. Short Answer type Questions:
1. Explain Signs?
2. Explain Resumes?
3. What is Banner?
4. Explain Newsletters?
5. What are Menus?

Exercise Exercise 
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6. Long Answer type Questions:

1. What are Advertisements? Explain 
various print media used for 
advertisements?

2. What are Business Cards? Write 

steps for creating Business Card 
in Publisher?

3. What is Label? Where labels can 
be used for?

4. What is Letterhead? How to 
create Letterhead in Publisher?
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Ï ÞÑŒPÒŎŌŒ Ì ÞÕPÒŐÕÑ FOŎÒŃÑ ĞÒÕÕ ÒŌ POÑ Ę ÕMŌÔŒ 
İ ǾÞÑ ŎǾ 

False 
ĲÑǾŘ Ĭ OŎǾP Ė ŌŒR ÑǾ 

Ĉ  e-brochures Products and services  True Sign 

Č  Business cards 
Business cards and 

menus  
True Envelope  

Ċ Resume 
Company and 

Individual  
False Award 

Ç 
Curriculum vita 

(CV) 

Education and work  
History  

 Flyer 

D    Newsletter 

 

Answers Key


